‘.lliI

IBM Connections 4.5
Deployment Scenarios

Deployment Scenarios

ERC 1.0

By WY




Deployment Scenarios

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide.

The following are trademarks of International Business Machines Corporation, registered in many
jurisdictions worldwide:

Cognos® DB2 Universal Database™ DB2®
Domino® FileNet® Lotus Notes®
Lotus® Notes® Rational®
Tivoli® WebSphere®

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other
countries, or both.

Java™ and all Java-based trademarks and logos are trademarks or registered trademarks of
Oracle and/or its affiliates.

Other product and service names might be trademarks of IBM or other companies.

June 2013 edition

The information contained in this document has not been submitted to any formal IBM test and is distributed on an “as is” basis without
any warranty either express or implied. The use of this information or the implementation of any of these techniques is a customer
responsibility and depends on the customer’s ability to evaluate and integrate them into the customer’s operational environment. While
each item may have been reviewed by IBM for accuracy in a specific situation, there is no guarantee that the same or similar results will
result elsewhere. Customers attempting to adapt these techniques to their own environments do so at their own risk.

© Copyright International Business Machines Corporation 2013.
This document may not be reproduced in whole or in part without the prior written permission of IBM.
US Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.



Deployment Scenarios

How to install Connections V4.5 on Windows

About the author

Tracy Green has worked for IBM, initially with Lotus for 17 years. She
has been an Advisory Software Engineer with the Dublin System
Verification Test team for the last eight years, and has worked on a range
of IBM products, most recently IBM Connections. Tracy can be reached
at tracy green@ie.ibm.com.

Contents

—

. Environment description

. Media requirements

. Environment preparation

. Middleware installation and configuration steps
. Database server and Tivoli Directory Integrator
. Installing IBM Connections 4.5

. Post-installation configuration

0 N O O b~ WO DN

. Extra suggested configuration steps

© Copyright IBM Corp. 2013 How to install Connections V4.5 on Windows 1

Course materials may not be reproduced in whole or in part
without the prior written permission of IBM.



Deployment Scenarios

Environment description

The test environment that is described in this article is a 2-Node Medium Cluster running on
Windows Server 2008 R2 Enterprise 64-bit edition that uses Microsoft SQL Server 2008 R2
database back end and Microsoft Active Directory 2008 LDAP repository.

The Windows Domain is .LITBG02.SWG.USMA.IBM.COM.

Host name Function RAM Disk space

dmgrHTTPsrv WebSphere DMGR+HTTP 8 GB 2 CPU 60 GB

wasNode1srv WebSphere Application Server Node1 8 GB 2 CPU 60 GB

wasNode2srv WebSphere Application Server Node2 |8 GB 2 CPU 60 GB

sqITDIsrv SQLServer + Tivoli Directory Integrator |8 GB 2 CPU 60 GB

Host name |Function Branch # Users
. OU=SharedLDAP,OU=Lotus,OU=Software

LDAPsrv | LDAP repository Group,DC=litbg02,DC=swg,DC=usma,DC=ibm,DC=com 300k

Media requirements

Download the following media to begin your deployment:

« IBM Installation Manager 1.5.3

« WebSphere Network Deployment 8.0.0.5 Media
« WebSphere Supplements 8.0.0.5 Media

 IBM Tivoli Directory Integrator 7.1 + FixPack 5

« IBM Connections 4.5

2 IBM Connections 4.5 Deployment Scenarios
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Environment preparation

On Windows, for the computer to have the HTTP server and plug-ins, you must download and

install the Microsoft Visual C++ 2008 Redistribution Package. In this case, it is installed to the
DMGR computer.

__ 1. Setup an NSF4 Shared Area for the Deployment Manager, Node1, and Node2 with read
and write access. For this configuration, it was done on the DMGR, share named
ConnectionsShare.

Organize ~  New folder

=| 4 Favorikes el o Type
B Desktop keshare Z7/03/2013 12:37 File Folder
g Downloads

. Recent Places

=l 4 Libraries

# | = Doouments
o Music
+ [l Pictures

+a1n'idms

*

=B Compuber
i Local Desh (1)

B ConnectionsShare (il

¥ lcshare

+ &l Network

Figure 1. DMGR - ConnectionsShare
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__2. From Node1 and Node2, locate ConnectionsShare and select Map Network Drive. Select
the same drive letter on each node and check Reconnect at logon.

%. Map Network Drive I

£ &1 Map Network Drive

Yhat network folder would you like to map?
Specify the drive letter for the connection and the folder thatyou want to connect to:

oive: | - |

Falder: F dmgrHT TPsnAConnectionsShare _"] Browise, .

Exarnple: Y\servershare
¥ Reconnect atlogaon
[T Connect using different credentials

Conneckto a Web site that wou can wse to store wour documents and pictures,

Finish I Cancel

Figure 2. Map Network Drive

__ 3. Install the JDBC driver for your corresponding database server on DMGR, Node1, and
Node2 computers to connect to the Connections databases when created. This driver
should be installed to the same location on each computer.

For SQL Server, download the SQL Server JDBC 2 driver from the Microsoft website and
follow the instructions to extract the driver files.

IBM Connections uses the sgljdbc4.jar file.

4 IBM Connections 4.5 Deployment Scenarios © Copyright IBM Corp. 2013
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Middleware installation and configuration steps

meﬁl
Note
-7 ~
After completion of each of the installations, select "View Log File" to check for any errors.
& J

1. Install IBM Installation Manager 1.5.3.

2. WebSphere V8.0 is installed from the Rational Installation Manager, so the latter product
must be installed first on the three WebSphere computers: DMGR, Node1, Node2.

3. Fromthe DMGR, run install.exe to start the installation and display the welcome screen.
You then see the following screen:

Install Packages
L D

| st altion Backages. | Bahe [ grion | ficmres ey Tipe ]

B verson 1 53

[ R Thach Vi -mwm.ruu.w:-mm_l

Dl

A It allalion Mansger |50
BN D Pres mlatnon Mlareges Moe 0fo
& Bpokory: CdnioacdiPTrn soert rataler il el i 15 00U 0] 10

| =N | ==
Figure 3. IBM Installation Manager - Install Packages
__ 4. Click Next to continue.
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__ 5. Accept the license agreement and click Next.

all st 'u.-..n.,.-ﬁ
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Figure 4. IBM Installation Manager - Install Packages - License agreement

___6. You can adjust the installation path if you want. Click Next to continue.

& 18 It

Install Packagos =
bt 0 hint it Fie [iost lladicn Mharicageer

ot b Rl Lt ey

}o O instsesd, 10 Instalation Marager wil be used bo it update modify, mansge snd uninetsll your paciagss,

Erit alkabe. Maruer Dy ectory: jt:'ﬂm.lrruuum Mo ke Brosess.,,

Dk Space Information

Vobgre  Avalable Space
] 2T G

Figure 5. IBM Installation Manager - Install Packages - Select location
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___ 7. Asummary screen is then shown. Click Install to complete the installation of the installation
manager.

B 101 prst allation Manager

Install Packages E
Pty by ftennelnry Il ormalion. ;-

Tiargil Listabion
Pachisge Group Hame: 1604 It alation Manager
Fretalishon Dyecory: O/ EMIntalahon Manager | sdipas

Packages

‘ L B beglalatior Manager 1.5.%

Environment Dhisk Space Information
argbic, Brackan Porbagues, Caech, Danish, Englsh, French, Garman, Grest, Mungsisn, Total v pdsble Space
[akian, laparese, Forsar, Lituaran, Boksh, Fussian, Sepified Chawse, Skorenin, Searsh, = i
Travdtionsl Chiness, Turksh 2

Tobsl Coswriosd Soec  FlE 46 HE
Tobal Inatallation Sie: 20083 ME

¥ Repostory informastion

? T | e B

Figure 6. IBM Installation Manager - Install Packages - Summary information

___ 8. After some time, the installation completes and you should see the following screen:

B 10 st allatesn Manager

[=1o] =]

Install Packages ! ;

9 The paschages arw iratalad. Yigwr Log Fils

e Follcesnsg package v rrtalad:

= % TEM Installabhen Marager
TEPAR: Irestalation Marsger 1.5.3

ek Puataaet Soitallatin, Manges” ba Lk thes e Bitialabuns Maniages atel b5 ftart evitalation of oifes Sackagelil.

Festart Dnstalation Mansgs
Figure 7. IBM Installation Manager - Install Packages - Installation successful
__ 9. IBM Installation Manager is installed. Repeat on Node1 and Node2.
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Installing IBM WebSphere Deployment Manager

__ 1. Copy the WebSphere Network Deployment installation media and the WebSphere
supplements installation media to the DMGR and extract the files.

___ 2. Start the IBM Installation Manager and from the main menu open Files > Preferences.

__3. Inthe Preferences window, select Repositories.

8 rreferences H=E
[ Repositories e et
Reposioriss
Arpearance Reposkories:
Files: For Rolback: Location Cornection I Add Repositony,
+ el !
% Inberret ; ; |
Pasapl Acvantsgs
U aters. —J

hﬁm are: remote kecations whene updates or extensions bo packages (inchuding the: Installation Manager kself) are
stored,

W Sesrch servcs repositones during nstalstion and updstes,

RestoreDefots | spoty |

Figure 8. IBM Installation Manager - Repositories
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__ 4. Click Add Repository and in the Add Repository dialog browse to the repository.config
file under the location where you extracted the installation media for the WebSphere
Application Server Network Deployment and click OK to add it.

& Add Repository
Add a repository .
Specify a repository and add to the repository preference list. U
Repositary:
I C:dnloadi PO IEM WebSphere Application Server Mebwork Deployment Y&, 0 repository, config j Browse, ., I
ik Cancel

Figure 9. IBM Installation Manager - Add a repository
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__5. Click Apply to save the changes and OK to return to the main Installation Manager window.

B 180 Installation Manager - (O] x]
File Help

IBM Installation Manager
. r_'I Install
I Instad software packages.

= Update
.1 Discover and nstall updates and
, fiers o installad software packages.

Roll Back
Modify

5= Al :
| ‘/P’ by adding or remeving Features nd '.“"_._,_ Uninstall
Functians. -

Figure 10. IBM Installation Manager - Main screen

___ 6. Onthe main Installation Manager screen, click Install.

___7. Inthe Install Packages window, select the IBM WebSphere Application Server Network
Deployment package and click Next to continue.

& 1M Ireskallation Manager = S |
Install Packages - g
Sebact packaged 1o iratal =
Jretalakion | Statn [ vorder [ Lizerrin ey Ty |

= =] n - z Willbs ratslad ]
O o o versions ek o O Versiors, Feces, and Extersine.

Dt aide

10 WebSphere Applic ation Server Network Deployrment 5.0.0,0

1EM WeetvSpines & Appdcatn Server Metwork. Depleymant 1 4 produdoneresdy v Plechom, Entespese Edton {1ave EE) complant sppbosbon senver o the depicarent of enterprses web
pervices solutions for dyname e-business. 0t s the rent vl in apoication seevirg beond the WebSohers Apokcaton Server base edtion becmusns & orovides advanced web osrvices and
dhritering tagabidbes. Mo info,.

» Pospesiory: O Linkead PO EM WebSpier o Appdeafion Seveer Mebworl. Depleyensnd w0

Figure 11. IBM Installation Manager - Install Packages
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___8. Onthe Licenses agreement page, review the licenses and select | accept the terms in the

license agreement if you would like to proceed with the installation and click Next to
continue.

__9. Onthe Shared Resources Directory page, remove Program Files (x86) from the
installation path to install to the I1BM\ IMShared directory. Click Next.

B 104 Iratallation Manager I.

M= E3

Install Packages ot
Select alocation for the shared eseurces deectory. ]

wher you ekl packages, fies e stoned i e kecstion:

1) The thared Feiuress drechiry « resiuross Bhat can be shared b sl packaget.
i ) The ratalstion deechory - ey resources that s unigue o Ha package st you sre netaling

Dwpertank: Wous can onky select the shared resources de ectory the first bime you instiall & paccage wath the B8 Gratalstion Manages. For best results ssbat the dive with the most
arvinlable wpace biciuse & mut hivs Eagaats 15608 for the thaned risourie of Nuture pachage

Shared Aesares Dnectory: | C-UBMIMShared I_H - 'J
sk Spade Infermalion
Wb | Avadisls Thade
£ .80 G0
i} <k [ mers || ||| coeeel

Figure 12. IBM Installation Manager - Install Packages - Select location

___10. On the Package Group Name page, remove Program Files (x86) from the installation
path to install to the T1BM\WebSphere\AppServer directory. Click Next.

Install Packages

o
A piachag (r U 5 4 lcaten that Conta of of Sne BackagRs. Some congatibls packages can be irskaled Into 8 comman packads groug o wil thare 4 common e inber a0s. Q
Sebact o eaisting package QROUD; OF CRAhE A NEW OnE

s}
(&) Craste 4 new package group
e J ekl Dwectary | Architnctirs |
e, 100 WhebSphae Application Server bstweork Deploymend VL0 £t webdohenel Acpderver

Fackaga aroup Name: [ Wel:Sphera Soplc ston Sernves efrork Depleyment ¥5.0
Irestalstion Dirschory | COBHW ehSpher el A pGerer L

Dt
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LT 24 4T ol
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Figure 13. IBM Installation Manager - Install Packages - Package group name
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___11. On the languages selection page, choose your language (the default here is English) and

click Next.
B e Inatalation Manager HHE

Install Packages

Selesct, B Erareslations b it el 4
Translations

e [ Evasan Pastuguese O ceeeh O Frerct 0O Gerrear

O Hursgarian [ ntalans [ Japaneia O vorean [ Py

O riomiarian m [P O Smplfied Chiness O sowsh O rradtional Chiness

7 <tk | meaz || 00 || cocm |

Figure 14. IBM Installation Manager - Install Packages - Translations to install

___12. On the Install Packages page, everything should be selected for a 64-bit environment
except IBM 32-bit SDK for Java, Version 6. Click Next.
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Install Packages .
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Figure 15. IBM Installation Manager - Install Packages - Features to install
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___13. On the packages summary, verify your selections and click Install.
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Figure 16. IBM Installation Manager - Install Packages - Summary information

___14. On the Installation Summary page, on the “Which program do you want to start?” screen,
leave the default option Profile Management Tool to create a profile selected and click

Finish.
& 184 Installation Manager P= E2
Install Packages —
g |
[T,
@ Thee packages are Pobaed. Yiesr Log Fils
Tt Fplbensas) Bach e i rit abedd: ety e i (b 40U et L Sae
= Y 1BM WeebiSpere Applcation Server Network Deployirend VB0 (B Prafibe Marsgerert Tood 2o craabe a pralle.
I 1B Wieh Sphesre Bppllcabion Server Network Deplorymnent 8.0.0.0
. * o e © Profle Management Tool to create an applcation server profils For & development 1
2 tione
| | il
Mot: [F ther pachages support rolback, the bemporary directony contsins rolback fles For irataled packages. You car delste Ho Fles on the Pl For rolbck preference page.

:

Figure 17. IBM Installation Manager - Install Packages - Installation summary page

The WebSphere Customization Toolbox 8.0 application should now start.
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___15. In the Profiles section of the WebSphere Customization Toolbox, click Create, and on the
Environment Selection page pick Management. Then, click Next

| 4% Profile Management Tool B0

l Environment Selection

Solect & specific bype of environment to oreabe.
Ervironments:

= WrakSpkers Anphc aton Sarver

Cell {deployment manasger and a federated applcation server)

Pelnr g
Hppbe stion sarvérs
Custom profie

Secure prowy (configur stoneoniy)

Descriphion

A management profle provides the server and servioes for mariaging multipls spplcation server environments. The sdrministrative sgent
servers on the samé madhine. The Network, Deployment

; manages applcation
edition alzo includes & deployment manager fior tighthy coupled management and & job manager for loosely
coupted management of topologees detributed over multipe machnes,

Figure 18. Profile Management Tool 8.0 - Environment Selection

___16. For the Server Type Selection, choose Deployment Manager and click Next
| #F’rl:l[l‘h! Managpement Tool 8,0

Server Type Selection

=

Selact ths bype of server bo be erested within this mansgement profils
7 Administrative agent
An admirestrative sgent provides management capablity for multiple stand-slone application servers. An administr stive agent can manage ondy the spplication
servers that eist within the: same: installation on ons machine,

1" Deployment manager
A deployTant rramagenment capahdy for multipls federated nodes. A dephoqrient manager can manags nodes that span mulipls systems snd
platforms. The podes that sre mensged by & deployment manager can only be managed by & single deployment manager and must be Fadersted bo the cell of
that deployment manager.

" Joh manages

A jobs manager provides managemant capubdty For multipls stand-slons application servers, sdministrative agents, and deplovment manasgess. The job manager
can manags nodes that span mukipls systems and platforms. The nodes that uememwdbymjoh manager alsn can be managed by other job managers,

« Back et > | Cancel |

Figure 19. Profile Management Tool 8.0 - Server Type Selection
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___17. Select Typical Profile Creation and click Next.

4 Profile Management Tool 8.0 - |O] x| I
Frofile Creation Options : ﬁ
0

Chioorse the profile creation process that meets your needs. Pick the Typical opkion to allow the: Profile Management Tool bo assign & set of default configuration values bo
the proifile. Pick the Advanced option bo specfy your ovan configuration vahsss for the profile.

% Typical profils crastion
Create a deployment manager profils that uses defsul configuration ssttings. The Profile Management Tool assigns unique names ba the profils, node, host,
and cell, The bool also assigns unique port values, The administrative console will be instaled and you can optionaly sedect whether bo enatle administrative

se0rity. The tool might create 8 system servios bo run the: deployment maneger depencing o the operating system of your maching and the privileges assigned
1o Yo Leser AoCount,

Mobe: Defaul personal certificabes expire noone year. Select Advanced profile oreation bo create & personal cestificate with a diferent sxplration,

" Advanced profils creation
Create & deployment manager using daf okt configuestion sebtings or specily your own valees for settings such as the location of the profils snd names of the
profie, rode, host, snd cell, You can assEgn your gwn port values, You can optionally thoose whether to dephoy the sdministrative console. You might have the

ophion to run the deployment manager as a system service depending on the operating system of your maching and the privileges assignaed to your user
BOCOUNE.

< Back Beset > i concel |

Figure 20. Profile Management Tool 8.0 - Profile Creation Options

___18. Enable Administrative Security and enter credentials. For example, use wasadmin for both
user name and password. Click Next.
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Chiooss whather bo enatls administrstive securiy, To enabls security, Supply & user name and password For koggng into admirestrative tools, This admnistratioe user i
craated in & neposiony within the spplcation server, After profils creation finiches, you can sdd more users, groups, of sdermal repostones,

¥ Ensble administratie securky
Lisar name:
| wrarsciman
Password:
I LLLLLL L1
Confirm password:

I sssssnna

Seer thes information center For more informaticn about adminidtrsthes securty,
Wiew the criine nfonmation center

< Back Mt > I Carel

Figure 21. Profile Management Tool 8.0 - Administrative Security
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___19. On the Profile Creation Summary page, review the information and click Create to complete

the profile creation.

o Profile Management Tool 8.0

Profile Creation Summany

=] E3

FReview the information in the summary for correctness. IF the information is correct, cick Creabe ba start creating a new profile. Cick Back Lo change values on the

pravious pandls,

Apphcation server anvronmant bo creabe: Management
Server type: Deplopyment manager
Location: C:\IBMWebSpharelAppSarveriprofies|Deangr 0l
Dk space puired: 30 MB

Profis rasne: Degrd]
Mk this profile the default: True

Celname:  sqiTDIsrv Calinl
hode name: SOITDISM CelManagendl
Haost name: <l mycompany. com

Deplory the admirsstr st corsole (recommended): True
Enable admirisirative seourity (recommended): True

Administrative consols port: 5060
Bedrranistrabhes conSols sacurs port: 9043
Dapioymant manager bootstrap pork: 509
Deployment manager S0AP connector port: 8879

Run deplmyment manager &5 & service: Tue

< Back

| concel

Figure 22. Profile Management Tool 8.0 - Profile Creation Summary
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___20. The Profile Management Tool wizard starts the process of creating the profiles and reports
when it completes. When done, select Launch the First steps console and click Finish.

# Profile Mansgement Tool 8.0 HE m

Profile Creation Complete o)
]
I\

The Profile Management Tool created the profile successiully.

Thea peeck shesp in cresting a Matveock Deployment ervrorement is bo stact the deployment manager 2o that nodes can be federsted into its osll, After the deployment
feanager i skarted, you can administer the nodes that belong to the cell.

Yious can start and stop the deployment manager From the: command re or the First steps consola. The Frst steps console also has bnks to an installstion veeification best
and other information and Festures that relste bo the deployment manager,

[ Launch the First shens conssls,
To start the Profils Managament Tool later, uss the PMT comenand in the aon_ sacver rootbiniProfledansgement deectory o the aption in the First steps consols,

[ Feh ]

Figure 23. Profile Management Tool 8.0 - Profile Creation Complete

___21. From the First steps screen, choose Installation Verification and review the output. Your
Deployment Manager starts and you can now log in to the console by using the wasadmin

user created earlier.

W Stort STAF 3,34

M
al

AL I ne
F ne nickname
shup Eime

At -1 A1

TAFProc wverzion 3.3.4 initialized

First steps

llllr.l.‘lll.‘:hn:l verificatlan
Confirm thal your sanser is installad and thal & can start proparly

Start the deployment manager
Stan the deploymenl manager and 15 applicalions

Administrative consola

install and adminisier applications

WebSphere Customization Toolbox

Launch this ioolbox to access the Profile Management Teol and »
acoess (he Migration Management Tool and migrate WebSphara /
or 7.0 profiles to version 8.0

Infarmation center for WebSphere Application Server
Learn more about WebSphere Application Server and explore sar

Figure 24. Profile Management Tool 8.0 - First steps screen
Congratulations! Your Deployment Manager is now set up. Now go to your application
server nodes.
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Installing IBM WebSphere Application Server

__ 1. Copy the WebSphere Application installation media to Node1 and extract the files.
___ 2. Repeatthe steps 2 - 6 from Section "Installing IBM WebSphere Deployment Manager".

___3. Inthe Install Packages window, select the IBM WebSphere Application Server package
and click Next to continue.

B 1B st allabion Sanager

Install Packages

—
Sedect packages tortal: }ﬁ
Pt ity |5ums |'|lmd0l |Llcmlcw'lmu |
[l s et
B L vermon s Wil b et alind 1M

[ Show sl varsions | hoeck Fox Cther Vorsiors, Feoms, and Extenions

Detalls

B WebiSphere Apphcstion Server B.0.0.0

Tha B wiebdohens dpphcstion Sereer Farmly i the eadng open dandade-based Levs Platform, Enberpeiie Edition [lavs B ) conphant spplcation faundstion of ferng brosd prograsmng
wnded cheomce and lowser bokal ook of oveneershap Bhieiagh heghs peformance e heghs manags abeilly:

Webfphewn Applcation Server deleers the gvalabdly ard secunty piur business degerds on whle optimizing ootk Mo infig

* Reposbory Chdniosd PO WebGphars dpplcation Server ¥O0L0

|Hh!:-|| | cancal

Figure 25. IBM Installation Manager - Select packages to install

__ 4. Repeat steps 8 - 11 from Section "Installing IBM WebSphere Deployment Manager".
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__5. Onthe Install Packages page, everything should be selected for a 64-bit environment
except IBM 32-bit SDK for Java, Version 6 and Sample Applications. Click Next.

B B it allation Manager

Install Packages ; Q

Select the features o rstal

Festures
= Bl o wetiiphene igplcstion Server 0.0,0,0
B Embehoy bool for pre-£70 3.0 modles
< BAL . Sard-skone thin chenks, repoorce sdipters and smbesddbls conkarers
B Soareialons then chents ancd rotourcs acdiphben
B Esboddabie EX6 contairer
O semple spgtestion
= BT =M Sofrwire Developrsnt K
O =032 50K for Lava, Varsion 6
B s 5Dk for Java, Yerson 6

[Exparcd || cotpse 1| [Restore Dol

0 St dependencins
e Selertod by Irotalalion Marager Becsurie of dependarcied

Details

e WebvSphere Application Server B.0V0.0
Fhee 1B WebSpher s Applcation Server famiy & the lesdng open standands-tarsed Lava Plstform, Enterprise Edbon ( Jave EE) compliant apphcation fourdation off erirg broad programeeng

el chosor and ke Total 0os oF Cererihip theough Pigh performare s and high managesbdty,
WebSphere Aok st Sarver delvers the s lahdity i Gty your buiinerss degeencs: of whis Dobinrg o

sk Spaste Enformaation

‘Wole Fmqured Tegaw oy Tats! ol
Thares] Basources Area DOy oL.2ER g Bl brdl R ]
Lrest ey D mchory L+ LD 118 G Fefl R ]
i shak | metz || || e
Figure 26. IBM Installation Manager - Select the features to install
How to install Connections V4.5 on Windows 19

© Copyright IBM Corp. 2013
Course materials may not be reproduced in whole or in part
without the prior written permission of IBM.



Deployment Scenarios

___6. Click Install and monitor progress.

Install Packages A
ey e Gy El S '

Larget Localon

Pishage Group hsre: T Waebiipfaw s Appicstion Serves VL0
Brertallation Daractony: CIEM WebSpharsl AppServer T
Fhared Resorces Drectory:  C/UBNUMSared

Packapes

L] 1B WebSptere Apphostion Serves BU0LOL0
L EMBDwpicy Rl lor pre-E 38 3.0 moeciides
Srand-shores B dlenits, resoircs sdapbers and anerishle conksnes
L Sranchsiore Hran dlends and resooscs sdspbers
v Ernbesciciabiles 38 cond-siness
1B Sioftweane Development Kt
U0 IE0 b S0 Foe e, Viersion &

Enwironmsent Dk Space Infonmeakion
Erglshy Tobsl dvslshls Space
1= 2290 B

Tobsl Dowwicsd Sze:  TBEZ KB
Total Imtalabon Sew; 1, 10 GO

¥ Repos@tcey Infonmation

St ; Extractvs) Sp oot i, restsiptens, XN, S4B pok I8, sarckor 13844 0.0.0.203 10402657 (i of 1 ME)
L —————————— :

Figure 27. IBM Installation Manager - Review the summary information

___ 7. When it completes, you are asked to create an Application Server Profile. Select Profile
Management Tool to create a profile and then Finish.

B 1ns ek allat wn Maiges

Install Fackages Q

9 The pachages sre nefaled, Visws Log Pls

Thee Folossamg pachage v insh aled: Which program do. yoas want bo staet?

= 1 WebSphens Sophston Server VLD
L B webSphene Aopllaton: Server 50,00

) Profibe Mansgement Tool b crests a profie.
Gﬁ@kmwl Wil L dr enpder Sy ol oy i ver ool or B (Jemreboimtr o
O pore

i | | Ll

totes B the packages supcaont rolbick, e bempsr ary diesctonry contard rolback Fles For iretaled packages. Wi can delebs the Fles on e Plies for rollseck preference guge

y

Figure 28. IBM Installation Manager - Start creating an application server profile
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___8. Inthe Profiles section of the WebSphere Customization Toolbox, click Create, and in the
Environment Selection page, pick Application server. Then, click Next.

&% Profile Management Tool 8.0

Emvironment Selection

= o

Salect 5 spacific type of environmernt o creste.
Environments:

‘ =1 WebiSphere Applcation Server

Managsinent
ppkcation server]

Drrscriplon

An spplcstion server efvironment funs your snterprise applcstions, WebSphere Appleation Server = managesd from it own administratiee consoke and functions
independerthy from all cther application servers.

Figure 29. IBM Installation Manager - Environment Selection

__9. Onthis screen, select Typical profile creation.

iﬂil'-"rufiln Mansgement Tool 8.0 !EIE

Prafile Creation Options =lg
i

o

Chioose ths profile creation process that mests your needs, Pick the Typical option to aliow the Profiles Management Tool o aesign & sat of defaul configuration valses to
the profile; Pick the Advanced option to specly your own configuration values for the profile,

1% Typical profils crestion

Crasbe an applcation server profile that ures delault configuration settings. The Profils Management Tool assion: unigue names bo the profile, nods, and hast.
The bool slso assigns Lnique port values,. The admingstrative console and the default spplication vl be installed. You can optionaly select whethor to enable
adminiskrather seounty, The bool might create & system servios to run the: spplcation server depending on the operating system of your machine and the
privieges aodighed Lo your USer Sooount.

Moke: Defaul personal certficabes expire in onm yeor, Salect Advanced profils crestion bo create a personal certificate with a different expiration,

1 Advarced profls crestion
Create appcation server using defsult configur stion settings or specly your oen valuss For settings such a5 the location of the profile and names of the profils,
riode, and host, You can B2sign your ovn port valoes, You can apbionally choose whether bo depdoy the sdiministrathve console and Sampls applcations, and
craate & Web sarver dafinition. You might hase the oplion bo run the spplication server &% & syshem sarvice depending on the cperating system of your mackins
and the privieges assigned to your user account,

« Badk Neak > gt Canoed

Figure 30. IBM Installation Manager - Profile Creation Options

__10. Repeat steps 18 - 21 from Section "Installing IBM WebSphere Deployment Manager" to
enable security and complete the profile for the Application Server and verify the installation.
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You should see the following result:

Installaticn ve

s First steps oulput

084N 3 13 3420959 15T) 0000000 win
[0BM41 3 13 3420931 15T] DODDOD0M Wi
JOEMDAN 3 1 3:34: 700994 (ET) DO00000d wip
ADR4N 3 1 334200996 E5T) 0000000 wip
R4 3 1334 20:958 £5T] 0000000 wip
IDRM4N 3 13:34:21:000 15T) 0000004 whp
JOB041 3 133421003 EET) 0000000d wip
:jl!ﬂl'ﬂ-l."‘l 3 133471005 IST) 0000000 wip
TR 3 1 3342104 5 E5T) 00000000 wip
02413 133421 017 15T] 0000000 wip
08104113 13:3421:026 £5T] 0000000 wio
AOEA04A 31 334: 21028 I5T) 00000004 wip
{DRMAM 3 13-34:21-030 15T DODDAD0G wip
HDRI4N 3 133421033 15T 0000000 wip
10804713 1334:21:035 15T] 00000004 wip
JOB041 3 133421037 EET) 0000000 wip
J0EMD4 3 13234, 22025 IET) 0000000d wip
02411 3 1334 26520 15T] 0000000 wio
R4 3 1334 76:523 15T] 0000000 win

W org echkpse st j2es commanarchivecore. infernal sirategy LoadStrateqdmpl createfie FileNotf oundExcepho = |
W oorg achkpse jst 2er commonarchinkcong intirnal siradegy LoadStrategdmpl crgateFite FileMolF sundExcaplia
W org eckpse jst j2es commonarchivecone internal sirategs LoadStralepdmpl createFile FilehofF oundExcaplio
Worp eckpse st 2ee commonarchivecore infernal strategy Load Strategyimpl createfile Filetotf ound Exceptio
W org eckpse j5t f2ee commaonarchivecone infternal sirategy. LoadStrategyimpl crealeFita Filetolf oundExceptio
W org wcEpse st j2ee commonarchivecone internal strategy LoadStratemimpl createFiby Filetolf oundExcaptia
Worg echipde fut j2ee cormmonar: hivecone internal strategy LoadStralegimpl crealeFibe FileholF oundExtaplia
W org echpse jst[2ee commonarchivecore internal sirategy Load Strategimpl crealeFile FlleMotF ound Exceptio
W org echipse jst j2es commonarchivecore intamal sirategy LoadStrateqimpl createFibe FlleMNotf oundExcaplio
W org eckpse st j2es commonarchivecone.Infernal strategy. LoadSirateqyimpl cresteFile Filetiolf sundExcaptia
Woorg pckpse jst j2ee commonarhivecong intrnal strategy Load Stralegdmpl crealeFit FileNotF oundErcptio
W oy echpse ot j2es cormonatcivecone internal strategy LoadStratepmpl createF e FileholF oundEscaptio
W org eckipse ist j2ee cormmonarchivecore internal stratagy Load Strategyimpl crealefiba FileNotF oundExceptia
W org ecbpse js5t[lee commonarchivecore internal sirategy Load Strateqdmpl createFite FileMolf cundExcaplia
W oorg eckpse j5l ek commonarchivecond internal Slrategy LoadStalbgpdmpl cradliFile Fi|tHﬂFerl'lﬂED(¢nllﬂ:
W org echipse jstj2ee commonarchivecore internal sirategy LoadStraleqmpl createFite FileNotF pundExtephio
W oeg eckpze jst 2ee commonarchivecone internal sirategy LoadStrategyimpl crealefibe FiledotF oundExcaplio
‘W org eckipse j5t [2ee commonarchivecore infernal sirategy LoadStrategyimpl crealeFile FileNolf oundExceptio—)
W org echpse jitZer commaonarchiecon internal strategy, LoadSirategyimpl croateFile FileNolF oundEcceptia

WTLOD0D B3 grroradwarnings ang detected in the COBMWebSpheredppSenarliprofiestippSnl 1 ogsigerer SystemOul log file |
IWTLOOFOL: The Installation Vet ation Tool wercation succeedad

:Ffl‘Ll:lﬂﬂl:ll: The installation verification s complele

Figure 31. First steps output - Installation verification

Congratulations! Your Node1 Application Server is now complete. You must now repeat all
steps in this section to install the Application Server on Node2.
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Federate Application Server into Deployment Manager

1. First, ensure that the clocks are in sync between all three cluster computers, that is,
Deployment Manager, Node1, and Node2.

2. Your Deployment Manager should be started and your Application Servers on Node1 and
Node2 should be stopped.

3. Then, from Node1 open a command prompt at C: \IBM\WebSphere\Appserver\bin and run
the following command:

addnode.bat dmgrHTTPsrv.mycompany.com 8879 —user wasadmin -password wasadmin
-localusername wasadmin -localpassword wasadmin

Node1 should be successfully federated as shown in the following figure:
x| Administrator: Command Prompt

: Tunl information iz being lﬂHJLd in file
STBM~HehSpheresAppSe rverd\pr AppSrvBlslogssadddode . log

nDHUB1 281 = ﬁtﬂpr-nj tnnl with the ps
CWHPKIB3BARI - ner alias "LH lar " to local

(& . he rullnnlnq SHA digest:

D B = BE : :59: 46:5D:DB: HP 81
CWPKIB3IR9I - i e ys J ady in local keystore.
ADHUBAA1] = Lha @1 w ment Manager

ADHUBBAY 1 -

es for node vdelarvHodeBi
as a UJnlua; Service,. the
he completed by stopping the

aszociated UlndnH'
: Deleting the old bhackup dllLLiur3

Backing up the original cell repozitory.
: Creating Mode Agent cnnf:qU|at1nn for node:

Adding node ! 1arvNodeBl configuration to

s for node:
1 for NHode Agent proc

.
. Waiting for initiali
HndL figent initialization com ed success ullu Pluﬂ 55
g p 5

rz fFound in configuration:
rver ndnu: no wgent
E :'I‘Vfi.l
~vHodeBl asszociated with serverd is now

HodeB1 was successfully added to the

: ﬁnu cell level documents from the standalone waslodelsrvCell@l
conf i ki . ] migrated to the new cell.

: Update the cunf:quvntlnn on the waszl 1 Celldl Deployment Manager
with valuez from the old cell-level documents.

: Mote:
: Because —includeapps was not specified, applications installed on
the andalone node were not installed on the new cell.
You might want to:
ADHMUBA3IAST = Install applications onto the dmgrmachnCelldl cell using wsadmin
SAdminfipp o the Administrative C 1
ADHUBRA3] = Mode wa zsrvMode@l has been successfully federated.

Figure 32. Administrator: Command Prompt
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__ 4. Logon toyour WebSphere Application Server admin console as wasadmin. Go to Servers >
Server Types > WebSphere Application Servers and you should see a server for Node1
listed.

S Sxmmdmam

Figure 33. WebSphere Application Servers Administration Console - WebSphere Application Servers

__ 5. Now repeat the same steps in this section to federate Node2.
Setting up the IBM HTTP Server and web server plug-ins for WebSphere
and the WebSphere Customization Toolbox

1. Copy and extract the media to the Deployment Manager computer. Then, start the IBM
Installation Manager.

2. From the main menu, select File > Preferences, and in the Repositories pane, click Add
Repository.

& add Repository | x|
Add a repository -
Specify a repository and add to the repository preference list, ‘
Repository':
| C:idnloadiPDS)IBM WebSphere dpplication Server Metwork Deployment ¥8. 0\ repository.config j | Browse... I
Ok, Care]

Figure 34. IBM Installation Manager - Add a repository

___ 3. Browse to the location where you extracted the WebSphere supplements installation media,
select the repository.config file, and then click OK.
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__ 4. Click Apply to save the changes and OK to return to the main Installation Manager screen.

& 18™ Installation Manager M=l 3
Fle Help
IBM Installation Manager
_| Install
'_-L Irestall coftware packages,
= Update
. Disoover and install updates and
Fixems o instalad software packagss.
Roll Back
— Modify
1§ /';’./7 Change instaled software packages -
B =l bry addng or removing Features and ‘l\r:-—'-' Uninstall
P functions. —
Figure 35. IBM Installation Manager - Main screen
__ 5. Inthe main Installation Manager window, click Install.
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___6. Inthe Install Packages window, select the IBM HTTP Server for WebSphere Application
Server, the Web Server plug-ins for IBM WebSphere Application Server, and the
WebSphere Customization Toolbox packages. Then, click Next to continue.

ey —" M= Ed |
Install Packages L
Sebect puschiages o Frtal: !
Inst et Pachages [ s [ vendw | License ey Type
= O Apchestion Chert lar [BM WebSphers Appkeahion Seros
O versen s0.0.0 15
- B B HTTR Sarver for Wabphers Appdestion Serves
Els versen s.0.0.0 vl b wsitaiend L]
= O Pusggatie Bppkiation Chent for B WebSptei Ao st Setives
Ol versen 20000 154
- B web Server Plugens for [B8M WebSphers Applcstion Server
Els verson 20000 ol b wsitaabiend 1
I s Sishaid v ettty Tl
=T il bt et 15

1 st all v sices | hesck For Cither Wérsions, Foss, and Extensions

[t il
Webphers Cuslomiralion Toslles: 8.000.0

WelSphene Customization Tooko provides baoks bo smphy and rapedly oustormee a WebSphere Apphcstion Sereer ensronment More info
= Repository O idnkosdPOSUIEM WebSpher s ARDECaton Server YEL0 Supplsments

I B TR =

Figure 36. IBM Installation Manager - Select Packages to install
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___7. Onthe Software License agreement page, review the License Agreements and select “|
accept the terms in the license agreements”. When you are ready, click Next to continue.

ﬂ 10 I nat allafion Mg HF‘E
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ressirsred by rocmnbeer off w5, millons of sevice urds (HELE"), Processor Vishee Uinks (FYLET), or other evel of we
pescifind] by O

FEEM - Indesmaational Busress Madhines Corporstion of ore of B subsidaries.
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puthorioad L obtared.

Miesrranty Period” - ore vesr, sharting on the dabe the orisnsl Liverase & rantsd the koense. x|
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Figure 37. IBM Installation Manager - License agreements

___8. Onthe Install Packages page, review the group entries and verify the installation paths for
each of the three installation packages. Then, click Next to continue.

B 15 dnadalation i
Install Packages =
Thie: paschasgecs el e st it Ehes i shend prchage Qroups. Sebect the ucage (o bo dhange The it alabon Srectory.
e ot
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= Ty, BT Server VELG OB T TR Server
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= el Sbrveer Plageirn for 100 Wieb Sptms Apple alion Serves VA0 £ orm e {8 S5 ek g P
U el Server Phugren for [BM Web:Sphes e Spplabon Server 8000
= M e Cutbora aton oskaoe WE.0 g o il o {35 b St Tosdbans

eGphehe Cintomzatan Tookas 2.0.0.0

Pachags Groug Marme: 1B HTTP Sereer W0

Installstion Desdtony: | BT TFServer

Debadls sk Space Infermalion
Sroredd Frtources Dwnctory; CH0MChared Wolumes  Srvalable Space
= ILEa

Figure 38. IBM Installation Manager - Installation paths
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_ 9.

B 189 binstallalzn Maisge

Install Packages

Select the fesbures bo install

Next, verify the components that you want to install and click Next to continue.

A=)

B 1 web Server Pug-re for [B84 WebSphere ipplcation Server 0,000
# B w1 Aunbme Ervironment: for Java

= B weblphere Customization Tookax B.0.0.0

wieh Sarver Plug-re Configurstion Tool

Profie Management Taol (0% ariyh

35 Migr ation Marsagerent Tosl

Revreatn Dabalation Tool Far BM

BEEE

] e dogaradences

= Snlactod by Ientalation Flatager becausn of degeraionted

[t aa || cotopse | [ ostoes Dotnt

Details

T8 HTTP Seeves For ‘WebSphere Applcaton Serves BO0L0U0

B HI TP Server o WebSples Apphcation Server Drovides stvanded wel server capabiities with conghent managemerl a7 securty im 8 WebSiwrs Apphoaton 5

HTTP Serwer for WsbSphers Applcstion Server i based on igadhe HE TR Server
sk Space Trdormestion

Server efmwronment, [BM

Ve Fegared Terigcraty Tetsl  dvalale
Shared Resouries Aisa 0 0.0kE WL WILHME W@
Instalation Drechary #3053 MB 205IME W
il e | mers [ Carcsl

Figure 39. IBM Installation Manager - Select features to install
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___10. In the Web Server Configuration, use the default value of 80 unless the HTTP server must
be run on a different port. Optionally, select Run IBM HTTP Server as a Windows Service
and keep the default Startup type as Automatic.

B 17 Tt allstion Manages = |
Install Packages =
Filiry the configrarations For the packages ]

154 HTED e Lor Wibiphers & | Conliguratien for 1B HTTI Server lor WebSphens Application Server 8000
i Weh Server Configuralion Wb Server Configurstion

Tpealy' 8 port fusmber for IBMETTR Server G0 communcate. The del sl port s 50, I the delsul port i skesdy n
e, then changs o gnother port thet b avalebis, Furrng [ HTTF Server wathou ook o dcdminestrstive
garviinged saght terirh o of Eorts bedow {00

TR port: [0

Chaoss whethes 10 use & Windores service to run TBMMTTP Server, [F & service & oresbed, sl ssbect & starhup
by bo haree the Wirdiows serece start marualy or sutomaticaly sken reboobneg the syshen

FF Bun S HTTE Server a0 8 Wirdows Service

& Logonas alcal mysten scrount

™ Logon a5 & specified user acoourt

Tl wriste i that el B Winkowel dswrvics swt haves the Foliteirng user ighits

= Act o part of e coesatng Syshem
Ly 5 i B SETVER

Seatup i [ausomanc ':'I

7 <tk | meas | | [ cancel

Figure 40. IBM Installation Manager - Complete the configurations for the packages
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___11. On the Packages Summary page, verify the list of packages to install and click Install.

B0 181 Lrest all ation Manager M=

Install Packages

i
Praviass Bhe Smmsry il oamastion ]
Tarmget Localion
e B rend Sapctory; ;LR M T nd
Packages

| nstallabion Directiony |
T TP Saeer

= e, IEMHTTP Sarver WO.0
IEMHTTP Server for WeetrSpher s Apphcstion Server 800000
= By, Veteh Sereer Phogrd for [BM WebSphere Apphoston Serves Va0
“weh Sereer Phug-ins fod [BM 'WebGphere Apphostion Server S.000L0
a) ' TEM Rurbimes Ereronment for 1ves
F 'ersbSphers Cushomization Tookox ¥8.0
‘WiebGphers Customizstion Tookow BUOLOLO
L Wb Serves Plag-ne Configuration Tool
1 Profils Mansgement Tool (2005 ooly)
[ 2rk dagrabion Marwgerent Tool
{1 Bemobe instalstion Tool for TN

1\ Proge s Files (36| M WebSphe. ..

I Prgr-ae: Files |6 [UBSAWebSohe. .

Evyirgurunend sk Spaoe Infonmeation
English Totsl Avalsbls Spane
C 2139 B
Wit Doarbned Sime: 357,20 ME
Total fratalstion Sow I, L6 Gl

b Reposstory Information

et ] | ot ][ conce

Figure 41. IBM Installation Manager - Summary information

___12. The wizard installs the packages and displays the Installation Summary page. Make sure
that all packages installed correctly. In the "Which program do you want to start?" section,
make sure that the WebSphere Customization Toolbox option is selected and click Finish

to exit the wizard.
!F.lr:a

B i fenkallst s Managper
Install Packages — '!"

o The packages are installed. - Y Lo Fis

Thee: fodomsaneg pachages weng nataled:

Whach progras do you vant b Sar?

Yo [EM HTTP Server 0.0
I8 WTTF Sarver For WebSphers Apobcation Server BL0L0L0

() ekt Cucitiovriz ation Tooltes
O porer

= T, Wb Server Mog-re For MM WelkSphens Agpl stion Senver VLD

1 Winks Servr Phag-r for B e dohens Apple st Sareer 8,0,000
o Ty, WeliSphwes Customizgtion Tookas VL0

L Wislifphite Customination Tookes 8000

tgote: ¥ the packages support ralhack, the teegorery deectory contsrs: rofbach Files For inetaled] inackages. Yo can delete the fles orthe Ples: (or olback prefeercs page

Figure 42. IBM Installation Manager - Installation successfully completed
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__13. The WebSphere Customization Toolbox should now start. Select Web Server Plug-ins
Configuration Tool and click Launch Selected Tool.

&b WebSphere Customization Toolbox B.0

M= B3
Fl= Window Help
| € wekome
D welcome &3 | =0

Welcome to the WebSphere Customization Toolbox

Select & bool in the following Bst bo display the welcome information For that tool. To lsunch & tool, select a tool in the list, and dick {awunch
Selected Fool Alternatively, select Window > Open Ferspective and select a tool in the list.

List of provided toals:
Prafile Management Taal {z}05 only)

2105 Migration Management Tool

‘Welcome information for salected tool

Usé the Wb Server Plug-ine Conlfiguration Tool bo configure the Web server plug-ins For IBM WebSphere Application Server Yersion
8.0 so that your Web server and application server can communicate with each other, Learn more about configuring the Web server
plug-ins from the Web Server Plug-ins Configuration Foadmap For WWebSphere Application Server Version 8.0 or the online information
canker.

Web Server Plug-ins Configuration Tool

Figure 43. WebSphere Customization Toolbox 8.0

___14. On the next screen, click Add and enter the name and location for the web server plug-ins.

r .w/w/ Note ~

In this case, it is named dubxpcvm956 as it is being installed on the Deployment Manager computer.
&

J
&b web Server Plug-ins Configuration Tool 8.0 [ =]
Add Web Server Plug-in Location
Add a previously installed Web server plug-in location to wour working sek,
Web server plug-in location
Mame: |+:|m|:|rH'I'I'F'5w
Location: I Y IEMYWebSpher e\ Plugins| Browse.. . |
| Finish I Cancel |
Figure 44. WebSphere Customization Toolbox 8.0 - Add Web Server Plug-in Location
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___15. Click Finish and in the resulting screen click Create... for Web Server Plug-in
Configurations.

i dp websphere Customization Toolbox 8.0
File Window Help
= i@wngemtﬁ.qh:Cmfig.raﬁmlud £ welcome
€ web Server Plug-in Runtime Locations |

Hacne | Location

| add...
dmg;HTl'st CHTEMiwebSphers Plugns _II
Roadmag. .. I

4] I*]
@m e l@wﬁ__ = = =
Wb Server Definition | Web Server Type | Plug-in Configuration File | creste... |

Figure 45. WebSphere Customization Toolbox 8.0 - Web Server Plug-ins Configuration Tool

___16. Onthe Web Server Selection page, select IBM HTTP Server V8 and click Next to continue.

4 Web Server Plug-ins Configuration Tool 8.0

Web Sarver Selection 3 _}1

Sabact the Web sarver to oonfigure, Verify that the Waly server you select to configure hes besn installad,

& IBM HTTP Server Vil

™ Bpachs Web Server ¥2.2

" Lobus Doming Wb Server 8

7 Lobus Duvming Web Server Y7

T Sun Java Sysbem Web Server V6.1 of Sun Java Syshem Web Server ¥7.0
" Microeadt Inbarnet Informakion Sarvices V7

 Macrosoft Inkesmet Information Sarvices V6

Figure 46. WebSphere Customization Toolbox 8.0 - Web Server Selection
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___17. Onthe Web Server Configuration File Selection page, verify that the path to the httpd. conf
file is correct and that the port is the same as set previously and click Next.

& Web Server Plug-ins Configuration Tool 8.0

Web Server Configuration File Selection

Select the 'Web server configuration fils and identify the Web server pork bo configurs the Web server definition.

Select the: exdsting 168 HTTP Server hitpd.conf file:

|ciimmprTPserniconfintpd, cond Browse. .. I
Spacily the Web server poat:
]BIZI

< Back ot ; J Cancel l

Figure 47. WebSphere Customization Toolbox 8.0 - Web Server Configuration File Selection

___18. Onthe Setup IBM HTTP Server Administration Server page, leave "Setup IBM HTTP Server
Administration Server" enabled. In this case, the default HTTP Administration Port of 8008
is kept. Then, create a user ID and set the password. Click Next.

#th Server Plug-ins Configuration Tool 8.0

Setup IBM HT TP Server Administration Server

Optionaly configure an administrative server bo adminictar the Web farver. You can manage the Web ssnosr from a WebSphers Gpphcstion Sarer
adminkstrathre console by using the [BM HTTP Server administrative server bo control the communication betvesn hem,

¥ Satup IEM HTTP Sarver Administrstion Server

Speciy & port nuenber for 1B HTTP Server adeersstabion server bo commurecate, The default port is 8005, TF the defaul port i sleeady in use, then changs
o ancther port that is avadable. Running 16 HTTP Server adrinistation senver without noot o Administrative privileges might restrict use of ports below
1024,

HTTP Administration Port:

B

Opﬁ_ofdrcrudl:quw 10 and password bo sutherticats to the [EM HTTP Server Admirdstation Server from the WebSphers Spplcation Server

Ackranisteative console, The user 1D and passwond i encrypled snd stored in the ook sdmin. paceed fils, You can create sdditional ussr IDs after he
configuration by using the htpassed Uiy,

W Create a user iD for 164 HTTP Server Administration Server autheritication

Lser I0: | insademn
Password; | EREERREE
Corfirm passward; [snsnnnes]

< Back [k = | Cancel

Figure 48. WebSphere Customization Toolbox 8.0 - Setup IBM HTTP Server Administration Server
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__19. On the second Setup IBM HTTP Server Administration page, leave the defaults to Run IBM
HTTP Server Administration Server as a Window Service and Automatic startup.

dp web Server Plug-ins Configuration Tool 8.0
Setup IBM HT TP Server Administralion Server

Choose whether bo use & Windows service ba run 1BM HTTP Server sdminiztration server, The Adminkstration Server must be run as 4 Windows service to be
abie bo manags the web server from a WebSphere Application Sarver adminictration Conscks, IF & sarvice i craabed, sl celact & bartup type to have the
‘Windows service stark manually or automatically when rebooting the system.

¥ Bun IBM HTTP Server Administration Server a5 a Windows Service.

% Log on a2 & beal sydem soeount
" Lpg on as & speciied user account

Figure 49. WebSphere Customization Toolbox 8.0 - Setup IBM HTTP Server Administration Server

__20. In Web Server Definition Name, specify a name for the Web server or use the default value,
and click Next to continue.

B b web Server Phug-ins Configuration Tool 8.0

Web Server Definition Name : y

Lise & 'Web server defintion o manage a Web server through the WebSphers Applcation Server adeirestratie conscks or the wesadmin bool. The defindion nams
st be urague because this name Is used to iderdify this Waeb server in the administrative corsole,

Specify o unique Web server definktion name:
i [rrrre—

The Wb server defirition naene must not be emply aivd & mist rob contain the followang special charscters of space:

o=+l <szan "[1>#§~{}
Note: a period].) i not valid F it i the first character,

< Back Piect > C Cancel

Figure 50. WebSphere Customization Toolbox 8.0 - Web Server Definition Name
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___21. On the Configuration Scenario Selection page, select Remote and enter the fully qualified
domain name of the Deployment Manager. Then, click Next to continue.

dp Web Server Plug-ins Configuration Tool 8.0

Configuration Scenario Selection 3
Configurs the Web server plug-ins to the computer where the Web server exists, When the ‘Web server and apphcation server are nob on the same computer,
choose the nemobe configuration scenario. ‘When both Wisb senver and application server ane on the same computer, chocse the local configuration scenario. In
the lacal seensnia, the Web server dafindtion you craats in this wizard it defined sutomatically inthe application server,
~ Conffigur athon soenanio

{+ (Remote) Host name or I address of the appheation server

| dmgrHT TP s mycompany.com

™ (Local) Irstalation kocation of WebSphere Application Server

For the remote configuration scenaro, tha host name must be scoesside on the network, through one of the Following address Formsts:
Fully qualifed domain name system (DNS) host name

The: default short DS host name:
Hurmeric 1P addrass

< Batk Bk = cancel |

Figure 51. WebSphere Customization Toolbox 8.0 - Configuration Scenario Selection

___22. On the Plug-in Configuration Summary page, review the information and click Configure to
continue.

*— Weh Server Plug-ins Configuration Tool 8.0

Flug-in Configuration Summany

Tsnisal configuration sbeps are required befors starting the Wb server. Follow the configuration procsdure in the Web Server Plug-in Configuration e
Roadmap. Afterwards, you may start up your Web server and application server bo best your configuration.

Wieb server ko configure:;
IBM HTTP Sarver Vi

‘wieb server defindion:
webserver]

Plug-in configurastion file:
CAABBMWebSphersFlugns| configiwebserver | iphiginechg, xml

<Back  |[Configure =] - | Cancel [

Figure 52. WebSphere Customization Toolbox 8.0 - Plug-in Configuration Summary
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___23. On the Plug-in Configuration Result page, clear Launch the plug-in configuration
roadmap and click Finish to continue.

4p web Server Plug-ins Configuration Tool 8.0

Plug-in Configuration Result

SuccEss: —

The configuration has been completed suotessfuly.

Manual configuration sheps ane requined before starting the Wb server. Foliow the configuration procedurs in the ‘Wish Server Plug-in Configuration
Rosdmap. Aftervarnds, you may start up your Web server and application server bo best your configuration.

[ Launch the phug-in configuration roadmap|

Manual configuration scriph:
CAIEMT WekiSpher o\ Plugire |\ binj corfigurewebsarver | bat

Wab server bype configured:
[BM HTTP Server v

Web server defirstion:
webserverl

Plug-in configuration File:
CEVIEMT WebiSpher e Plugirs | configlwebseryver 1\ phugin-cfg. xml

4 o

I | [t |
Figure 53. WebSphere Customization Toolbox 8.0 - Plug-in Configuration Result
___24. You can now close the WebSphere Customization Toolbox.
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Update your Deployment Manager, Application Servers, IBM HTTP
Server v8.0, plug-ins, and WebSphere Customization Toolbox to
WebSphere Application Server 8.0.0.5

1. Because WebSphere Application Server 8.0 is using the Installation Manager, updating to
the latest fix pack it is easy. However, make sure that all servers are stopped before you
install the fix packs.

2. Start the Installation Manager and select the Update link.

3. Then, check Update all. Only the applications that are installed on your system are
updated, so you must repeat the process on DMGR, Node1, and Node2.

4. Enter credentials to the IBM Download Location when prompted.

5. Accept the License Agreements and click Update to apply the 8.0.0.5 update to each
application.

6. On your Deployment Manager only, you must also apply WebSphere interim fixes PM62615
and PM71430 in the same manner.
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Configuring the HTTP server for SSL

Connections supports login over SSL only, so you must configure the HTTP server to accept SSL
connections.

Creating a self-signed SSL certificate

Vs (ﬂ;“/ Note ~N

If you are going to use a certificate signed by a certificate authority for your deployment then, it is
not necessary to generate a self-signed SSL certificate.

To accept a certificate authority signed certificate, see Receiving a signed certificate from a
certificate authority at
http://pic.dhe.ibm.com/infocenter/wasinfo/v8r0/index.jsp?topic=/com.ibm.websphere.
ihs.doc/info/ihs/ihs/welc ikeymangui.html.

G J
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___ 1. To generate a self-signed certificate, start the iKeyman "Start Key Management Utility" from
the HTTP server.

[N Start STAF 3,34

nicknams =

irtup time

STAFProc w

“logsdmgrsstopiervsr, log

* ECOPp ECaAatus.

B e Sener ve0
MW Start HTTP Serves

. ebwac
B Start Key Managedment Lty
W Stop HTTR Server
Conkrol Panol
[BM Instalabion Manage:
E6M Tholl Directory Inbegrator v7, 1 Dndicss and Prickans
IBM WebSphers
. - T Admnstrathee Tooks  »
- Fiedp and Suppoet
- - _ﬂ R
4 Bk Windows Security

| Search programs and files f—"].. Logoff [#

Figure 54. Starting the iKeyman Start Key Management Utility

___ 2. From the main menu, select Key Database File > New, provide a name for the key
database file, and set the path to where you want to store this file.
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L |18 Eey Management M [=] E3
KeyDssbase File Creste Wiew Help

D& W %

Kery database information
DE-Type:
File Harma;
Token Lalsel:
Firy databiase eontent
[ LAT=TY 5
Kty databiase typs ;"'Jﬁ j - Pl
Filix Barm:: [hoe ety | Browse.. e
Location: CUBMHTTPSarsen
- . Imipnin...
[ox || coma |
Aecrigls FReguest
Fefeaine
Hitwd Sell. Signe]
Exdraci Certfcsia

[To stant, please sehoct the Key Datahase File menu (o work with a ki database..,

Figure 55. IBM Key Management - Key Database File - New

__ 3. Whenyou click OK, you are asked to enter a password to protect the file. Enter a password,
and select Stash password to a file. Then, click OK.

-'L11."-"I Key Management - [ L IBMHT TPServer key Jodb)
Hey Database file  Creste Miew  alp

D d % o4

Firy database infoemation
D Ty CME
Filie Nas: CAUBMHTTPSenvarkey kit
Token Labek

Emmmmm Password: |+eseses |=| Rittispe... [
i Comfirm Password: [ensnanan .

.| Expirastion time (s Vinw it
| | Stash password io a file

M w Hocreglo Rogqunst

Exiract Cortifcata
[The requested action has succossiully completed
Figure 56. IBM Key Management - Password Prompt
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4. The tool returns to the main panel of the Key Management utility with the new file opened.
Click New Self-Signed and enter the required information into the Create New Self-Signed
Certificate window and click OK.

Etreate MNew Self-signed Certificate

Please provide the Tollowing:

Key Label |Self5ignedCertiﬂ|:ate| |
Yersion ELTILRTE R

Hey Size 1024 |-

Signature Algorithm SHATWIthRSA |+

Comimon Mame {optional) |dmng'ITF"s N Mycompany.com

Organization (optional) |

Organizational Unit {optional) |

Locality {optional) |

State/Province {optional) | |
Zipcode (optional) | |
Country or region  (optional) -

Validity Period 365 | pays
Subject Alternative Names

Email Address  {optional) | |

IP Address {optional) | I
DNS Name {optional) | |
OK Reset Cancel

Figure 57. IBM Key Management - Create New Self-Signed Certificate
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__5. The tool returns to the main panel of the Key Management utility with the new self-signed

certificate shown under the Key database content panel. Exit the Key Management Utility
and proceed to configuring the HTTP server to use this certificate.

L 1B ey Managerment - [CUIBM HTTPServer key kil]

Koy Database e Create View  Help

D xR

Hiry datahase information
DB-Type: CME
[Pl M CUBMHTTFS ey kih
Token Labed:
Key database content
Pavsonal Cerlificates - RECUHE...
* SelfSignedCertificat e Deleta
View Edil...
Recregle Reguist...
Renama
 New Sell Signed_. |
Exract Corfificale..
[Thve requested action has successimy completed

Figure 58. IBM Key Management
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Adding the self-signed certificate to the HTTP server

Open the httpd. conf file under the C:\IBM\WebSphere | \HTTPServer\conf directory.

Enter an SSL virtual host stanza before the LoadModule was_ap22_module and
WebSpherePluginConfig sections:

LoadModule ibm ssl module modules/mod ibm ssl.so
<IfModule mod ibm ssl.c>
Listen 0.0.0.0:443
ServerName dmgrHTTPsrv.ibm.com
<VirtualHost *:443>
SSLEnable

AllowEncodedSlashes On

</VirtualHost>
</IfModule>
SSLDisable

Keyfile "c:\IBM\WebSphere\Plugins\config\dmgrHTTPsrv\dmgrHTTPsrv.kdo"
SSLStashFile "c:\IBM\WebSphere\Plugins\config\dmgrHTTPsrv\dmgrHTTPsrv.sth"

Save the file and restart the server. The server should now allow SSL connections.

Open the server URL to test.

—— e - '
http://dmgrHTTPsrv.mycompany.com ;

IBM HTTP Server
& | @ 1nformation | & | B Release
Administration center Support notes

Figure 59. Server URL
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Enable security on your Deployment Manager

The final step to complete the WebSphere Base Configuration is to add the LDAP repository.

URL:

1. Log on to your admin console as your WebSphere Administration User defined earlier at the

http://<yourWebSphereDMGR>.<yourorganization.com>:9043/ibm/console/logon. jsp

Ensure that Enable administrative security and Enable application security are selected.

Also, ensure that the user account is set to federated repositories.

e

T
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O et B
[ ol
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L [k Gl B (e P Sl WS RS T il R L et T ey, T ey | 8D R 18 T Ay Gl P el
Fe— i abrem P by w4 smnd mn ) dutead pms ey miay e cams @ ppleabaes . Smeart dmeaen pa e dwtend b s el st e et
e R
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e e [
o g i
Abuaiiratoye pey prily A ptmanb
Ly ""” P E AR bt i AR iettanhegmar wasbara e aa prmiaa
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Bpnae alise wes iy SATEEARY ClvlalNaas
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T Bkt s Sp
B Fratr G SulRasluaned BRI
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Figure 60. Deployment Manager - Global security
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___3. Select Security > Web and SIP security > General Settings. Ensure that Use available
authentication data is ticked. Click Apply and Save.

_ - -

Ghwhal iy Sk ety Cemnral s g

L T e A
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Feels ausibeanty ahos brhavsar
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I = ey Balhg il pig Wleps iy | d BORiSEd

Tmfac bn hams sedbasinbus s (eed we g St gt Lu b BT FL (b S
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Tl iem e g
B Usadh pad emeda
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B iy

b Rarran g
]

Figure 61. Deployment Manager - Global security - Web and SIP security - General Settings

___4. Next, select Security > Global security > Web and SIP security > Single sign-on (SSO).
Ensure that the Interoperability Mode is selected and enter the domain name. Also, enter
the LTPA cookie names as LtpaToken and LtpaToken2 and Apply and Save.

ek TTP v mysomipay oem

: :‘“’u bl e - gl sge e [ S500
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Figure 62. Deployment Manager - Global security - Web and SIP security - General Settings - Single sign-on (SSO)

__ 5. You must now federate the LDAP repository. Select Security > Global Security and click
Configure.
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___ 6. Select Add Base Entry to Realm.
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Figure 63. Deployment Manager - Security - Global Security - Adding base entry to realm

__7. Then, select Add Repository followed by LDAP repository. Enter an identifier, host name,
bind distinguished name, and bind password for your LDAP repository. Then, click OK.
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Figure 64. Deployment Manager - Security - Global Security - Adding repository
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___ 8. You are then asked to enter the base entry. When done, click Apply and Save.
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Figure 65. Deployment Manager - Security - Global Security - Adding repository and the base entry

__ 9. Restart your Deployment Manager and Node agents.

___10. Then, to check that security is enabled correctly, log in to your admin console again. Select
Users and Groups > Administrative User Roles. Select Add, select the Administrator
role, search for the user to use as your Connections Administrator, and add that user to the
Mapped to Role.
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Figure 66. Deployment Manager - Administrative user roles

___11. Select OK. Log out and log back in again as the user you chose, to ensure that it is working.

Important
r I] P ~N

You can run this test by using any user from the LDAP repository. It must be the user that is
specified during the Connections installation and not the default WebSphere Administration User
that is defined during the Deployment Manager installation.

A\ /)
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Vs “;“/ Note ~

Recommendation
Back up your WebSphere Base Configuration, that is, Deployment Manager, Node1, and Node2
computers before you proceed with the Connections installation.

- J

You now move to your database server.
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Database server and Tivoli Directory Integrator

Create Connections databases on Microsoft SQL Server

1. Itis assumed that Microsoft SQL Server is already installed and running on a separate

computer. To enable database connectivity from Connections, start the SQL Server
Configuration Manager and expand SQL Server Network Configuration. Select
Protocols for ICINST1. Right-click Named Pipes and select Enable.

P sql Server Configuration Manager

5 soL Server Network Configurstion {32bit)
= S0L Mative Chent 10.0 Configuration (32hit)
B SOL Server Network Configur ation
- Protocols for ICINST1
# B sSQL Native Chent 10.0 Configuration

File Action View Help

a7 = H B _ B

}Ej SCQL Server Configuration Manager (Local) Protocol Mame ] Status !
5 5GL Server Services ™ shared Memory Enabled

Dizabled
Enabled
Disabled

Mamed Pipes
ITCRIP
G via

Figure 67. SQL Server Configuration Manager
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2. The default port for SQL server is 1433. If your server is configured for dynamic ports, you

must note it for the Connections installation. From the same location, select TCP/IP and
right click to select Properties. Click IP Addresses from the resulting window and scroll to
the bottom. Note the TCP Dynamic Ports value, in this case 65053.

= sql Server Configuration Manager

File  Action Miew Help

e AU IEREY
@ S0L Server Configuration Manager {Local) Protocal Mame | Skakus |
| SOL Server Services W Shared Memary Enabled
H 50L Server Network Configuration (32kit) W Mamed Pipes Enabled
=2 50L Mative Client 10,0 Configuration (32bit) H=TCRIIP Enahled
J S0L Server Network Configuration YVIA Dicahled
= Protocols for ICINSTL
_S0L Mative Client 10,0 Conf TCP/IP Properties
Pratocal 1P &ddreszes I
= 1P6 -
Active Yes
Enabled Mo
IP address 2002:9a2;593f::9a2:594F
TP Dwnamic Porks ]
TCP Pork
B 1p7
Active Yes
Enabled o
IP Address Fedn:: 100:7F:Fle%al 2
TP Dwnamic Porks 1]
TP Pork
B 1rali
TP Dwnamic Porks 65053
TP Port |
-
Active
Indicates whether the selected IP Address is active.
] I Cancel Epply Help

Figure 68. SQL Server Configuration Manager - TCP/IP Properties
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3. Now extract the IBM Connections 4.5 installation media and locate the Wizards folder. Start
doWizard.bat, which starts the database wizard.
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Figure 69. Database wizard for IBM Connections 4.5

___ 4. On the Database task selection screen, choose Create and click Next.

h Dakabase wizard for 188 Connections 4.5

Database task selechon

Select the database tasi

¥ Cragts
" Delste
" Update cperation only for EB Connections database 4.0 to 4.5

Figure 70. Database wizard for IBM Connections 4.5 - Database task selection
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__5. Onthe Database selection screen, choose SQL Server Enterprise Edition and enter the
details for the installation location and database instance.

B Database wizard for [6M Connections 4.5

Database selection

Select the database type; installation location, and database instance.

™ B2 Universal Database (TH)
" Oracke Enterprise Edilon
% 500 Server Enterprisa Edtion

Destabacs irstalation location:

[C:'['Pm-qra'n Files Micrasoft SOL Sarver Browse... I
Duatabace insbance:

[ircmmsT

Figure 71. Database wizard for IBM Connections 4.5 - Database selection

___6. Onthe Application selection screen, choose Select All and click Next.

n Database wizard for IBM Connections 4.5

Applications selection

Sedact the applicstions for which you want to create databases, You cannot select applcations that aiready have datsbases,
Hoke: The Sesrch and Nevwes repositony spplications &re contaied in the Home page database,

Cogreos database is for Congos B Server. You wall nesd Cognos bo use Metrics.

¥ ctiities

¥ Eogs

[+ Bockmarks

W Cogres

W Commureies

[+ Fles

W Forums

[+ ' Home: pags

[+ 1B Connections Content Manager
W Metrics

[ Mo
¥ Profies
[ ks

¥ Salsct &l

Figure 72. Database wizard for IBM Connections 4.5 - Applications selection
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___7. Select Create from the summary screen followed by Execute.

& Database wizard for 102 Connections 4.5

Databasze creation detailed command

Thes Follovang commands will be executed, dick “Execute” bo run them,

Activities
1. C:Program Fies (cBSPIERNDEIv 10, binidb2cmd - -w
2. CtPrograe Filss («B6){IEMDBZ\v10. Vbl dbZerd -¢ -w

Blogs
1. C:\Program Fies (x86/\IEMMDE2 v i0. VbinidbZemd - -w
2. C:\Prograen Fies (xB6)IEMDEZvI0. Vbin)dbZemd -c -w

Bookmarks
1. CAPrograen Files (xBS)IEMIDEZ|vED. lbinidbhZemd -¢ -w
2. Ci\Program Fles (B6QIEMDEZ v 10, bin\dbZcmd -¢ -w

Cognos
1. CHiPrograen Files (xB6IEMDEEVI0. 1bin\dbZemd -¢ -w
2. CiProgram Fles CoOGNIEMDEZ Y10, 1\0inidb2omd -¢ -w

Comamunities
1. C\Program Files (xB6RIEMDEZ v 0. IbenidbZemd -c -w -
2. C:iProgram Fies (85 IEMIDEZ 10, 1binjdbdomd =¢ -w -

3. CiiProgrem Fies (xB6HIEMDEZ v 0. 1binidbZemd -¢ -w -
createDb. sql

4. C\Program Fles (xESHIEMIDEZ v L0L 1 binidb2emd =C - «
sppGrarts. sq

Files
1. C:Program Fles gr&&}pmvm.:mqu = o -
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-1 daZ bk v conrections . cafl activitie<\ dhZ spprrants. 2l
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Figure 73. Database wizard for IBM Connections 4.5 -

Database creation detailed command
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___8. Review the Post configuration task summary, click Finish, and then check logs for any

errors.

.ﬁ Dot abase wizard for 1BM Connecbions 4.5

Fost configuration task summany

Thes dlaksbage crestion bask complsted. The Folovwang configuration was used:

M[=1E3

Actuon: Creabe 16M Cormactions database
Dostabase bypen: DEZ Unicersal Duatsbase (THM)

Dustsbace instance: DE2

Manager, Metrics, Mobds, Profiles, Wikis

Sl scriphs ran: crasbelb.sql, sopiGrants.sq
Rest: The databarse crestion was successhul

Blogs

Diskabase wiser: LOLSER:
Sgl seripts ron: createDb.sgl, sppGrants.sg
Rosult: Thes databurse crestion was suciessil

Bookmarks

Dustsbace naeme: DOGEAR

Duatabase user: LCLISER:

Sl seripks ran: createDb.sgl, sppGrants.sg
Ressudt: Thes datsbusse crastion was successful

Cognas

Donitbiase Mol COGNCTS

Dot s er: LOUSER

Sl scripks ran: oresbeDbesql, sppGrants.sg
Resait: The database crestion was successiul

Comimunities

Destsbade mame ShCOMHM
BT

I ey A

[Dostabse inskall bocstion: C\Program Fies {86 )| IEMIDEZ w1001y

The: selected applications are: Adivities, Eogs, Boolmaeks, Cogros, Commundies, Fles, Forums, Home page, IBM Connections Conbent

m

Figure 74. Database wizard for IBM Connections 4.5 - Post configuration task summary
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You should now see all of the databases in the SQL Server Management Studio.

’« Microsoft SQL Server Management Studio

File Edit “iew Debug Tools  Window  Community  Help

: 0 o ey | O | B3 25 B B | R
|"'||:|'i eck E'--'|:|||'|r'F-r'

Connect ~ 4 4 .f" J ;

= [ Databases

[ Systemn Databases

[ Database Snapshots
|| BLOGS

L COGNOS

| | DOGEAR

|| FILES

| FHGCD

| FHOS

|| FORUM

| | HOMEPAGE

| METRICS

|| MOBILE

L OPNACT

| || PEOPLEDE

| | ReportServer§ICINGT1
Lj ReportServer$ICINST1 TempDE
L SMCOMM

L WIKIS

[ Security

[ Server Ohijects
[ Replication

[ Managernent

[% 2L Server Agent

Figure 75. Microsoft SQL Server Management Studio
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IBM Tivoli Directory Integrator 7.1 installation

The installation of Tivoli Directory Integrator is needed so that the Connections Profiles database
can be populated with LDAP information.

Recommendation

Install it on the same computer as your database server.

1. Extract the installation media and run the launchpad application. The welcome screen
opens.
— e - | Eat msctting |7 | 5w |
B Deiktop L lnchpad LOI0{2012 14:45 Fike foides
1§ Downloads L boense LORIZ0IE 1445 e Foider
1L Recerk Places L windoers a4 LONGRZOLZ 1444 i folder
- @] mtonn L2010 a0 S Information 1
S L— [ cubresbace VA0 1006 Compremed (oppe,. 105508
o s L #_popitry_dbsorpt FERA0I0 10:18 Compressed (nppe., X 3]
2 s (@lorciond a0 Kok i)
H Wikeei ? B Vvl Nrectory [ntegrator 7.1
M Comprter Tivell Directory Integrator
AL ol Pk}
i dnioad i =
ey Welcome to the IBM Tiveli Directory Integrator 7.1
¥ Walcom Launchpad
b IS ek shaes P
Release Information
L Mcronalt X8 fria
Prarsaiisite o mstion Tha 184 Thooli Cirectory Integrator 7.1 Launchpad provides an overview of the
Paifiogs ik 1BM Tivol Directory Integrater 7.1 rebaase, install prerequisites, nstall
Progeam Fles instakation Sconarios scenarios and migration information. The Lawnchpad akso provides finks to
am Pl detabed information abeut thase and othar miated topics. Links to the [EM
Frog ] i i
S Tgratian Intommaticn [Tivel Directory Integrator Instaler it alse provided,
g Irratal TBM Thvoli Directory .
E Integratos 18M Tivoll Directory Integrator perfonms real-time synchrondzation for data
Userz : rapoditores, with a special focus on identity data.
| Wirsdows &
* Web Sites:
[CRr— o ﬁ Praduct ste
= % Product decumentation
o @ Zuppont sita
2 & News gioup
igensed Matenals - Property of [BM Corp. & Copyright IBH Corp, #nd other(s), 2003,
2510, &l Reghas Resarvd. 1BH, the 1BM loge and Tvel are reguitersd trademarks of TBM —
Corporation in the United States, other cowndries, or both. Badt on Ecliose s a trademark of
\ chgde Fourdation, Inc. Jave and all Java-baded trademarics are trademarks of Sun
M sy FI-Tal 5 ok Bated Caabet aih G ol R s Ll i fad

Figure 76. Tivoli Directory Integrator 7.1 - Welcome screen
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__ 2. Select Install IBM Tivoli Directory Integration from the left navigator followed by “Launch
the product installation: Tivoli Directory Integrator 7.1 Installer”.

& Tivoli Directory Inte

Tivoli Directory Integrator

&BH Tivoli Directory Integrator 7.1 Installation

Welcome
Release Information Launch‘tha product installation:

i r fi r
Prerequisite Information

Installation Scenarios Installation documentation:
Migration Information

Install IBM Tivoli
Directory Integrator

Exit

Figure 77. Tivoli Directory Integrator 7.1 - IBM Tivoli Directory Integrator 7.1 Installation
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___ 3. Select your language and click OK. On the Introduction screen, click Next to continue.
P S |

» Introduction
> Previous Installations
- Bofware License Agreement
Choose Install Folder
[ Choose Install Set
> Bolutions Direclory
[ TDI Server Porls
- TDI Server Service

Integrated Solutions Console
Directory

~ Integrated Solutions Console
Part Values

- AMC Service
[ Pre-Installation Surnmary
[ Installing...
L Install Complete

InstallArywhere

W LEM Tivoli Directory Integrator v 7.1

Introduction

Installanywhere will guide you through the installation of IEM Treoll Directony
Integratorvr.1.

Itis strongly recommended thal you quit all programs before continuing with this
installation.

Click the ™ext bution 1o proceed 1o the next screen. Ifvou want 1o change
something on a previous screen, click the Previous' bution.

You may cancel this installation st any time by clicking the "Cancel’ buthon,

Figure 78. Tivoli Directory Integrator 7.1 - Introduction
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__ 4. Accept the license agreement and click Next to get to the installation location. Enter the
installation path and click Next.

2 IBM Tivoli Directory Integrator ¥7.1

 Introduction
« Previous Installations
+" Software License Agreement
¥ Choose Install Folder
[+ Choose Install Sat
- Bolutions Directory
[ TDI Server Porls
TOI Senver Service

. Intzgrated Solutions Console
Directory

Integrated Solutions Console
Port Values

[ AMIC Service

[+ Pre-Installation Surmrmary
[ Installing...
Inﬂmlci:lmp[ert_e_

InstallAmpwhera

Cancel

[ E3

Choose Install Folder

Please choose a destination falder for this installation.

Where Would You Like to Install?

| C:AProgram Fles\IBMITDTWVT .1
Resztore Dafault Folder

Choosze...

Figure 79. Tivoli Directory Integrator 7.1 - Choose Install Folder
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__ 5. Select Typical install and at the next screen select the Do not specify - use current
working directory at startup time option for the Solutions Directory.

W7 TE™ Tivohli Direc tory Integrabor v7.1

1n1E:Iurtiun
Previous Installations
Software License Agreement
Choose Install Folder
Choose Install Set
Solutions Direclory
= TDI Server Porls

- TDI Server Senice

Integrated Solutions Console
Directory

: Integrated Solutions Console
Port Values

- AMC Service
& Pre-Installation Summany
£ Installing,..
L Install Complete

¥4 8855

InstallArswhiera

Pl S

Solutions Directory

fou have the opfion of selecting a Solutions Directory, & Solufions Directory is 2
static directory where the IEM Tivoli Directory Integrator Server and Configuration
Editar loak far vaur solutions,

= Use a subdirectory named TDI under my home directory
 Use Install Directory
" Selecta directory o use

fen
Restare Cefaull ] Chinoee. |

& Do not specify - use current working direclary at starup lime

=4

Figure 80. Tivoli Directory Integrator 7.1 - Solutions Directory
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___6. Use the default ports and click Next to continue.

W& I6M Tivoli Directory Integrator ¥7.1

R T SR

Imtroduction

Previous Installations
Software License Agreement
Choose Install Folder
Choose Install Set

Solutions Directory

TOI Server Ports

TDI Server Service

.. Integrated Solutions Console

Directory

Integrated Solutions Consale
Port Values

= AMC Service

© Pre-Installation Surnmary
Installing...

© Install Complete

I E3

Server Port Values

Enter the port values 10 be used by BM Treoli Directary Infegratorvi 1 Seneer,

Server Port

|1m;

System Stare Port

[1s27

REST AP| Port:

|1lm

Syslem Queue Port

|+1m1

Figure 81. Tivoli Directory Integrator 7.1 - Server Port Values
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___ 7. Do not register the system as a service. Click Next.

W I6M Tivoli Directory Integrator ¥7.1

=[]

:?I_ntmducﬁun

&

FLLALSK S

Previous Installations
Sofware License Agreement
Choose Install Folder
Choose Install Set

Solutions Direclory

TOI Server Pors

TDI Server Service

. Integrated Solutions Console

Directory

_ Integrated Solutions Console

Fort Values

= AMC Senice
+ Pre-Installation Summary
= Installing...

© Install Complete

Installdmwhare

Register Server as Service

You have the option of registering IBM Thvoll Directory Integrator v7.1 Server as a
syslem service.

[T Reagister as a system serdce
Sarvice Mame
Jicisey

Figure 82. Tivoli Directory Integrator 7.1 - Register Server as Service
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___8. Accept the default ports for Integrated Solutions Console Port Values and click Next.

W 18 Tivoli Directory Integrator v7.1 == E3
: i

Integrated Solutions Consocle Port Values

Introduction

Previous Installations
Software License Agreement
Choose install Folder
Choose Install Set

Solutions Directory

TOI Server Pors HTTF port:
TDI Server Service 13100

Integrated Solutions Console HTTPS port
Directary {13101

Integrated Solutions Console
Port Values Action Manager APl port:

[+ AMC Senice [ 13104
> Pre-Installation Summary
O Installing... 5
~ Install Complete

Enter the portvalues to be used by Integrated Solutions Console SE.

& SRS SSSASASS

Y

InstallAmswhens

Figure 83. Tivoli Directory Integrator 7.1 - Integrated Solutions Console Port Values
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__9. Do not register the Administration and Monitoring Console as a service. Click Next.

¥ 18 Tivoli Directory Integrator v7.1

AMC Service

V' Introduction ‘fou have the option of registering the Administration and Monitoring Console as
+ Previous Installations a syslem senrice,

+ Software License Agreement
« Choose install Folder

+ Choose Install Sel

' Solutions Directory

 TDI Server Porls [T Register as a syslem service
«F TDI Server Service Semice Mame

Integrated Solutions Console Jdiamic
Directory

Integrated Solutions Consale
Port Values

= AMC Senice

- Pre-Inslallation Summar,r
- Installing... i
~ Install Complete |

InstallAnswwherns

Figure 84. Tivoli Directory Integrator 7.1 - AMC Service
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__10. Review the summary and then click Install.

W IBM Tivoli Directory Integrator 7.1 HE= B

Pre-Installation Summary

- Introduction Please Review the Following Before Continuing:
" Previous Installations
+ Software License Agreement Product Name:
 Chaose Install Folder 180 Tivoll Directory Integrator 7.1
«f Choose Install Set Install Folder:
v Sanaiong Dlresiory CAAProgram FilesUBMTDRVT, 1x

+" TDI Server Ports
+ TDI Server Service

Integrated Solutions Consale
Directory

Integrated Salutions Consale
Port Values

o AMC Service

¥ Pre-Installation Summary
[ Installing... d
[+ Install Complate

Disk Space Information (for Installation Target):
Required: 665,053,696 tytes
Available; 21,200,572 416 bytes

InstallArywhens

Figure 85. Tivoli Directory Integrator 7.1 - Pre-Installation Summary
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___11. When the installation finishes, clear Start the Configuration Editor and close the installer.

e R e e AT,

Introduction

<

Y AN SS SN S

LSS S

Previous Installations
Software License Agreement
Choose Install Folder
Choose Install 5et

Solutions Directory

TDI Server Ports

TDI Server Service

Integrated Solutions Console
Directory

Integrated Solutions Consale
Fort Values

AMC Service
Fre-Installation Summany
Installing. ..

¥ Install Completa

ongratulations! 1BM Tivoli Directory Integrator w7, 1 has been successiully
nstalled. Press ‘Done’ 1o quit the insialler.

[Cl51art Conflguration Editor

Figure 86. Tivoli Directory Integrator 7.1 - Installation complete

___12. Install Fixpack 5.

a. Ensure Tivoli Directory Integrator is not running.

b. Copy and extract the file 7.1.0-TIV-TDI-FP0005.z1ip to your file system and use
C:\Program Files\IBM\TDI\V7.1\bin\applyUpdates.bat to install the fix pack.

Run the following command:

TDI install dir/bin/applyUpdates.bat -update TDI-7.1-FP0005.zip [-clean [-silent]]
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Populating the Profiles database with LDAP user information

Vs 'w;“/ Note N

This section can be completed before or after installing Connections 4.5. However, the Profiles
database must be created by using the database wizard from the Connections 4.5 installation
media as in Step 4 on page 51 from Create Connections Databases on Microsoft SQL Server.

G J

Important
s I] P ~

For large LDAPs for example, 300,000 users, it is necessary to increase the JVM size of the Tivoli
Directory Integrator process that populates into the profiles database.

See instructions at Configuring Tivoli Directory Integrator,
http://www-10.lotus.com/1dd/lcwiki.nsf/xpDocViewer.xsp?lookupName=IBM+Connections+
4.5+Documentation#action=openDocument&res title=Configuring Tivoli Directory Integ
rator ic45&content=pdcontent.

Complete all steps in this document including "Make the database libraries available to Tivoli
Directory Integrator".

& J

__ 1. From the Connections Install Media\Wizards folder, launch populationWizard.bat
and click Next at the Welcome Screen.

H=E

& profiles population wizard for 184 Connections 4.5

Welcome to Profiles population wizard for IBM Connections 4.5

iThis wizard popudates the Profles database for 18 Conrections with users From your LDAP drectory.

To sccess information about this product, dick the Launch Trformation Certar.

Launch Informakion Center

chick Mext bo contirmees.

Livensed Malerials - Property of IBM. Licénss L CRAEEZYNME

SCopyrion IBM Conporation dad its Neankors 2007, 2013, AN Rights Resersd IBM, the (86 o, e car dod Lolus dré
tracemarks of IAM Corporation in the Unfed States, obber countries, or boblh, Qlber company product or Senice names may be
trackepaavk s OF S&TVice marks of oifers. A correrd fl of IBM Irpdemadrks i avaifabde on the Web o

was hm comffegaioomytnads siml UE Govermmend Uisers Resimohed Rights: Liss, duplioabion or disclosmrs resfricled by
G54 ADP Schadle Condract will IO (oo, Fagss see Bhe Ahow! page for foiher informalion

Figure 87. Profiles population wizard for IBM Connections 4.5 - Welcome screen
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__ 2. Locate the Tivoli Directory Integrator installation location and click Next.

& Profiles population wizard for IBM Connections 4.5

Twvoli Directory Integrator install location
E3 The wizard was unable to locste the Tivoll Directory Integrator in the def sukt lacation.

1EM Connsctions uses Tivoll Directory Inbegrator to popudate the Profiles databace. Specify the lacation of the Tholl Directory
Irtagrator prograen fles. Trook Directory Inbegrates must be verson 7.1, FisPack?,

Sedect the location of the Trnoli Directory Inbegrator installation directory:

ECE | Browse... I

Back Hest Cantel I:

Figure 88. Profiles population wizard for IBM Connections 4.5 - Tivoli Directory Integrator install location

__3. Select the database type at the next screen, in this case SQL Server Enterprise Edition,
and click Next.

& Profiles population wizard for 16 Conmnections 4.5

Profiles database type

Seleck the Profiles database bype.

™ D82 Unbversal Dakabase] TM)
™ Crace Enberpeise Edition
(' S0 Sexver Enterprise Edition

Figure 89. Profiles population wizard for IBM Connections 4.5 - Profiles database type
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__ 4. Next, enter the database information for the PEOPLEDB that you created earlier and click
Next.

& profiles population wizard for 1B Connections 4,5

Profiles daiabase properties

Enter the Profies datsbace properties, The wizard uses this information bo sccess the Profiles datsbace.

Host name:

[ salTDIsmv mycompany. com

Port:

| 1433

Cratabuxse name;

[PECRLEDE

JOEC driver lbrary path:

FC:I,h'b:n:-f.dt IDBC Driver 4.0 for S0 Serverisghidbe_+.04enu Broswse, ., |
Liser B0 {Account wsed bo wribe bo database):
[ PROFUSER:

Pasoword:

[ LRI LA LT Ll

Back Pk Canced

Figure 90. Profiles population wizard for IBM Connections 4.5 - Profiles database properties

__ 5. Onthe LDAP server connection information, enter host name and port information and click
Next.

£ Profiles population wizard for 18M Connections 4.5

LDAP server cannection

Speify the LDAP heost name and port bo enable the Profiles populstion wizard bo connect bo the LGP server,

LDWP server name:

| LD&Psn mycompany. com

LDVE sarver port:

B

Select bo uss 551 communication for seciuned access
™ Use S5 commurnication

bk [ Mo | el |

Figure 91. Profiles population wizard for IBM Connections 4.5 - LDAP server connection
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6. Next, enter the bind distinguished name and password to authenticate with the LDAP and
click Next.

& Profiles population wizard for IBM Connections 4.5

LDAF suthentication properties

Eriter the bind distinguished name snd passwand to bo allow the wizard bo access the LDAP deectory.
Bined distinguishad name (DR):

[ CH=wpshind, OU=sharedi 0P, OU=USA. DC=litbgl2, DC=mycompany, DC=com

Eirsd password:

Figure 92. Profiles population wizard for IBM Connections 4.5 - LDAP authentication properties

___7. Onthe next screen, you must enter the Based distinguished name and string for searches
and click Next.

& Profiles population wizard for IBM Connections 4.5

Base distinguished name and filter for searches

Enter the base distinguished nama and filter for this wizard to begin sasrching for users in the LDAP dirsctory trae.
LDAF user seandh base:

l Cll=SharedUDAP, OU=USA DC=litbgl2, DC=mycompany, DC=com

LOAP user seardh Filer;

[ (o= et et classmiretOngPerson))

Figure 93. Profiles population wizard for IBM Connections 4.5 - Base distinguished name and filter for searches
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___8. Review the Profiles database mapping on the next screen. You might not need to make any
changes. Click Next.

8 Profiles population wizard for 1BM Connections 4.5

Profiles database mapping

Sedect an LDAP attribube or & JavaScript function For each Field in the Profiles database.

;fmmsutﬂn colurmnies by sebackineg the column header, or select aach row to add, remove, or edit the LDAP sttribute or Lyvascriph
Database Fislds | LDAP Attrbubes or 35 Funchions | Descripbion | -
albmiakel Ak Alarnabe Last nams
bldgle Bulding
béosglLiel Blog knk.
calersdarLid Calendar link
counkry_ode £ Counkry code
courbesyTitle Courbesy bithe
deptiumber Department number
degeription deseription Al e i
chaplayfame o Harms
distirquishediame  $dn LDAP distincuished name
i mad Cifface emad
emploryeehiumber employeerammber Empicryes ramber
employeaTypeCode  smplnsstype Ermplayss bype
BT Beackiground
Faschhumber FacsimBstelephonerumber Fa ruamber
Flooe Flocs
Frewsbasylil FroefBusy time bnk
grvenilame grvenhlame dief 3t given name
givanhiames grveniame Supported mulkiple geeen names
groupmarsEmal Abernste emal =l

et Cancel
Figure 94. Profiles population wizard for IBM Connections 4.5 - Profiles database mapping
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__ 9. Accept the defaults on the Optional database tasks screen and click Next.

n Profiles population wizaerd for TBM Connections 4.5

Optional database tasks

Sadack the chesck boo For each byps of optional infiormation that you want bo add, You sust supply & C5V File with data for each

information type.

[ Countriss

I
[ Departments

I Organizations

I
I_'Errﬂuwetrpts

[

[T work locations

Do yosus wesnt o run the bask that marks the profies of sach manager?
(= Yos
™ Mo

¥

LEEEER

k[ wet | conen

Figure 95. Profiles population wizard for IBM Connections 4.5 - Optional database tasks
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__10. Review the summary screen and then click Configure.

n Profiles population wizard for IBM Connections 4.5

Frohiles population configuration summany

Profis pepidation wizard i ready Lo run the populstion with the foliowing configuration,

Configuration detads:

Db abace host name: sl Dilsiv mycompany, eom

Dusbabass isms: PEOPLEDE

Diatabase poet: 65053

JDEC deiver lbrary path: C:\Morosoft J0OC Derver 4.0 for S0 Serverisglidbc_4.00enu
Databaces user ID: PROFUSER

Draskabaess bype: S0L Server Enterprse Edtion

LEwaF host mame: LDAFsy MPACOMpSITY, COm

LDWF server port: 389

Eand dlestinguishied nasme: Chlmswpebaned, Ol Shared DAP, 0U =154, DC=Rbg02, DC=rpcompary, DCmcom
LOAP user search base: OUsSharedi DR, OUsLISA, DE=Rtbg(l. DCamcompany, DC=com
LOAP uter sasrch filter: (Bduid="*){objactclassminatOr gPerson))

Thvod Directory Inbegrator nstalation lacation: C:AIBMLTDNV?.1

s 55U comemunication: Mo

Optional bask kst Mark managers

Ta change any settings, cick Badk, To begin the configuration, dick Configune

Back Configurs Cancel

Figure 96. Profiles population wizard for IBM Connections 4.5 - Profiles population configuration summary

___11. This configuration can take a number of hours to complete depending on the size of your
LDAP. In some cases, it might fail and you must follow a manual workaround to complete
the population. The problem is that Tivoli Directory Integrator runs out of memory, and even
by increasing it to 10 GB it still runs out depending on the size of the LDAP branch. What
you must do is:

__a. Editprofiles tdi.properties and ensure source ldap page size=1000 to capture
all required users.

__b. Run collect dns.bat from within /Wizards/TDIPopulation/win/TDI on your wizards
for Connections. It creates a file that is called collect.dns, which contains all the users
to be populated into PeopleDB. You must put this file on a Linux computer and split it into
20,000 chunks (split -1 20000 collect.dns collect-split).

c. It creates a bunch of files called

collect-splitaacollect-splitabcollect-splitaccollect-splitadcollect-split
aecollect-splitaf.

© Copyright IBM Corp. 2013 How to install Connections V4.5 on Windows 73

Course materials may not be reproduced in whole or in part
without the prior written permission of IBM.



Deployment Scenarios

Copy these files back to your Wizards folder under /Wizards/TDIPopulation/win/TDI
and then create a batch file, for example, Mypopulation.bat with the following code in
it:

for %%? in (collect-splitaa collect-splitab collect-splitac
collect-splitad collect-splitae collect-splitaf) do (
copy%%? collect.dns

populate from dn file.bat

delcollect.dns

Then, run Mypopulation.bat to populate the remainder of your LDAP branch. Any
duplicates that the wizard already populated are skipped.

You now move back to your Deployment Manager.
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Installing IBM Connections 4.5

r 'M/m/ Note ~

The Metrics and Content Manager applications are not installed as part of this configuration.

The Connections 4.5 installation is done on the Deployment Manager computer and then synched
with the nodes, so make sure that your Deployment Manager and the nodes are started.

- J

1. Set the maximum heap size on the DMGR. In the Admin console go to System
Administration > Deployment Manager > Java process management > Process
definition > JVM. Set the maximum heap size to 1024. Save and Close.

2. Extract the installation media IBM Connections 4.5 win. Then, start the IBM Installation
Manager.

3. From File > Preferences, click Add Repository and go to
IBM Connections 4.5 win\IBM Connections Install Windows\IBMConnections\repos
itory.config. Click Apply and OK.

B rreferences H=1E
[ Reposilones . - -
Repasiteries )
s o afece Rapoalon kg
Filers fior Roduack L sk | Connmection | P o
# Help B coldrkoadFOS|EN_Conrections_4,5_wanlIEM_Connections_Inetall ... 3
# Inbesrest
Passport Advantage
Lk ers
Thesw Cradantisis
Teest Connections

Service reposkonies ans remobe locations whene updstss or extandions o packages (nchudng the Instsllstion Mansger R2el'] ana shoredl
¥ Search servica reposikories during installation snd updates.

Restore Dsfoks | ooy |

Figure 97. IBM Installation Manager - Preferences - Repository
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__4. Then, select Install, which should open the Select packages to install window with
Connections 4.5 listed. Select this package and click Next.

allation Manager

Install Packages -
Epbeck puckaged bo watal
ETE | Merder [icormeroytpe |
= E 1]
El verson 4.50.0 will bee instaled
O show al versiors Chesch For Gther versions, Pross, and Extersions
Diebads

EBM Conmections 4.50.0
250 Connetions Instalstion More ifn..,
® Regostory: Cidnioad POFUIEM_Connections_4.5_winl[BM_Conrections Bt sl Windows| IBMConnections

Figure 98. IBM Installation Manager - Install Packages

__ 5. Accept the license agreement and click Next.

Install Packages =t
Pl Bt ol il ayroiiventi Carmtully,
_-_,_,_ Vo e
= IBM Cornections Correchens Notioes H
JE Conectiod s
Alarn | O Lconis

i Connactions Liceras Agreesoert T AP BRANCE PRERSE 5 5 RN OpEN-20 08 P pert Dabwsn dae o Sollwied & Shginering Da0pis i &0s mberested in BOP St lave.
1B Connections Lierds Information TETHCT sl Hrar e cocde provadad] by AP Allance i Publc Doman,

2.0 Lipersed Softwane

Program inchces the: follosng Bpadhe 2. -k arged softeare
pibscier.s (1% 0, Roaom 1,275, Ol 3.0 _3, CaLb 2.7, Cb-no-dep-1.7, Commons 1T TP Chent L0, 3.0 RCA, 2001, 4.0, 4.1.2, Commons
Eaary Ui 1.6, 1.7, Commong Coaes 1.3, 0.4, Commons Colection 3.2.1, ot Corfiguraton 1.5 (meifmd], HTTP Cong 4001,
K ornemons DECE 1.2, 1, Commons Digester 1.5, 1.7, 0.8, 1, Commons Fis Uplosd 1.0, Commons Fiks Uplosd .21, Commans 10
{4 Commarn Lare 2.4, Commans Loggng 1004, Commona Poal 1.3, Commiats Yaldator |, 1,3, Conmons Yaldetor 1.4, fisth DAG
IFramework. 2.2.0.638, lackson 1508 Pocessor wl.8.1, 1BM Lucere Jiva SDK (LIS) 2.4, Jacksor 1508 Processs 180, JWH 25,8,
D 2200, Logs] 12,01, Lo 1.2 12, Lugene 1,9,1, Lucens Tarm Heghlighter 2,2.0, Lucens 30,3, Memet] 0.6, Mplistis 2,3.5, Spring
EEE, SUAKART 8000, Steipes 1,55, Sonues Z0UEE, Sirutd 20308, Tk Plugnd D04 o Sonuts, Struts Tile 2004, Tnts § 0.4, TagSoug
1.2, Wekocity 1.4, WikiModel 2012, PL Seourity 1460, WOSLT4] Viarsion 2,74, I ML BPTs 1.3, Quartz 150, Sersloer, XML &R 1.2 and
phLdl,

RIS ot tha Apache 1, 0Hicerasd softmane wiche the bermes andl concitons of the Followsrg Iceness

Fiuaeite it Verian 2.0

T ]

[t e apache oroficanses)

[TERMS ShD COMOITIONT FOR LSE, REFRODUCTION, AND CISTRIEUTION

1. Dofirdsonss.

MLicorris™ druall mnan thee Dere ared condtions for use, reprodiucton, and ditribauton i defmed by Sectors 1 through @ of this dooument
[Licarnon ™ shall mea the copyrght twner or eritily authorged By e ooprright cerae Tthat, b granting the Licecas,

(Lol Eriity”™ shsll e tha undon of Ehe actirg snbity anedl sl other snbities Bt control, are controlled by, or are under commmon control
Jeaith (st eritity. For thes purgries of ik delirtion, “conirol” mesr () Lhe poeer, drect of elredt, bo dose he de et o managemen

jof suach ey, whether by contract or obherwise, o (8 ovwnership of ifty percent (507 or mone of the cukstanding shares, of (&)
Bearsaficial cowrepribin oF sasch enbity, ll

G!mﬁdﬂeﬂmnd‘gkmwm

Q) £ ot acepd i Eerrl 0 K Roonss gy semenli

Figure 99. IBM Installation Manager - Install Packages - License agreement
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___6. Select the installation directory for Connections and click Next.

B 1B Dreatallakion Manager

Install Packages

A package grodp & & dacstion that contare one of more padkanes. Some compatbls packages can be inetalad it & comvon ackags groun snd will dhare 5 coaan user inteelsce Q

Talect 40w DAk AN Qroug, O Cresbe & e of

oL

£ Use the sritivg package oo
{E) Comale iy iwtes pischisg gring

g Mg

| it atation Smackory

i B Conrechors

Pk ieges Grongy Miies: 160 Linuddtionel

S\ E Cornactions

Installetion Dwectory: | CoBMConnetions

Dehaily.
Shared Resouroes Deectony: OIS aed

Disk Space Informaticn

Wolme  Evalabis Space
0.2

[eoek [ nams |[ [ el

Figure 100. IBM Installation Manager - Install Packages - Installation directory

___7. Next, choose the packages to install. For this configuration, you can choose to clear Metrics
and IBM Connections Content Manager. All other applications are installed. Click Next.

B 1B st allakion Sadiager

Install Packages

Selenct the Peabires b bl

Feshses

B sewh
< @ MFeshres
Butrelties
o
Bk
Comennkies
Fias
Foruma
Matrice
L
Mk e
tralies
ks
= O sddonFeahuss

00 1M Connesctions Conbent Manage

cafcafiafis] mfia foefiafiufeefesl

[ Show dependences
i Sebected by [estallabon Manager becase of deperdences

Dt ils:
Prlewics

Thee Metrics applostion i requeed for dsts captues. Even F ipou are not ssbting up Cogros et instal Matrics nosy 2o that your applcston data b capbarad from the moment that BB Conrections
i deplrpec]

DHsk Spare Infasmabion

Woive Resguirad
Shared Fegources dees ZELBED
Erestillestioon: Derecturny C phfe ]

Tesrge by Tatsl bl
103 s 1.09 B 20,238
7.5 0238

[Lw.unl||mmn| limmn:la..t

Figure 101. IBM Installation Manager - Install Packages - Features to install
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___ 8. Enter your WebSphere Deployment Manager Details and credentials. The credentials that
are used here should be your Connections Administrator and not wasadmin. Click Validate

and Next after the validation is successful.

B 181 [erstallation Manager

Install Packages
Fllin the configueations o the padanes

B |

i

Cormenon Conligural ions
Webiphere

oo Confaps stiore

& Weldiphers

O Toguigy
sk aburis
Condent Firs
Mot o

Wehaphere Ak abse Serwer Selecian
Erestaliation foscsbioy
[ e —
Deghrymreert: manager peofie;

[Eerarty =

Harsd e

[amgHT TFar mycompany com

Dieploynsent Manager Credentials

Thseas credenitish must et for the selected Profis,
Admireirabor uier [

[connAdmn

Adrraretrabor [usseed

| eanansns
vadste |
Nipleatbe crocheniusl. before procesdng

Figure 102. IBM Installation Manager - Install Packages - Configurations for the packages
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__9. Select Medium for the deployment type and select all check box for each application. Then,
click Next.

B 1B st allation Muansger

Install Packages !

Fill in tre configuestions for the pacheges.

= I Common Configurstions Ceamumen £ enfiguritions
E webiSphern Topokagy
& Mepkogy' =
O Duaban Depyment bopology W
L Cordait Rore
O sorlieation St e dephnment Lypa:

O Gl - N gl e B0e rouped i e s Cliiler
O Mo - ﬂwlcd_mvmmdn-s;rmalm-
i Larpe - Ksch spplcation & qroupsd in i own. duster

Chister

Enber & cherber name or sebet anoeodsing chesber naes, Then pelert the rodes for sach dhosber and snber & Semver names o
irept the defaull server rare,

Reore Defadia
| Applcstion [ ster 1_[oe [serve 1

Agttes Cheter] B gl TP rebicdellt Chister]_server |

e Chuter? B el TP ebiante Chiter2_gerwen |

Bookmarks Chuster B droHT TPavhiodel Chusterd_server]

Commeriias - Chaterl B ST TRanvhloden Chister]_server ]

Fien Chator? B dogl TPweliodeli Chater_parwin |

Forume: Chyster] B il IPrebicdelt Chuster ]l _server]

Bore page InfraChster B drg TTPardlodel Infralster_garverl

Halde trdraChater B drarHTTPardlodall IrdraChater_gorverl

Modsgtion [InfrsChate B il IPareicdellt IrifraCh ter_sarverl -

Kk InfraCister el IPeretiadell InfraCister_esverl

Frafied Chtir] B dtiE TP eehiadelll Chamer]_forwir |

Samch Infraichmter B dophl TPrdicdell Infrachster_ssrverl %

1l | LlJ
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Figure 103. IBM Installation Manager - Install Packages - Configurations for the packages
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__10. Enter the database information and ensure you can connect when you click Validate. Then,
click Next when the screen displays that it is successfully validated.

B 181 It allstosn Manager

Install Packages
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Figure 104. IBM Installation Manager - Install Packages - Common configurations - Database location
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11. You must now enter the details for your Connections Share. For Windows, specify the file

location by using the Universal Naming Convention (UNC) format. For example:
\\server name\share name. Ensure to test read/write access to this share from both

Nodes. You must also specify the local content store. It should be in the same location on
both nodes. When it is validated click Next.
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__12. You can select None for notifications.

Information
-0 \

See the information center for how to configure notifications, which can be done after installation:
Configuring Notifications,

http://www-10.1lotus.com/1dd/1lcwiki.nsf/xpDocViewer.xsp?lookupName=IBM+Connections+

4.5+Documentation#action=openDocumenté&res title=Configuring notifications ic45&con
tent=pdcontent.

.
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Figure 106. IBM Installation Manager - Install Packages - Common configurations - Notification
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___13. Review the summary information and then click Install.
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Figure 107. IBM Installation Manager - Install Packages - Summary information

___14. After it completes, check the logs for any errors.

15. You should now stop your Node Agents and Deployment Manager. Then, start the
Deployment Manager followed by your Node Agents. Check the Node agent logs for
activity, similar to the following results:
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Figure 108. Node agent activity
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__16. Leave it for about 30 minutes and then start your Connections Servers. To do it, log in to
WebSphere admin console and go to Server Types > WebSphere Application Servers.
Select each Connections cluster and click Start.
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Figure 109. Connections Servers - Application servers

___17. When it is started, check all logs to ensure that no errors occurred and that startup
completed successfully. Logs are found in
c:\IBM\WebSphere\Appserver\profiles\AppSrv0l\logs on each node.

IBM Connections is now installed but there are some additional post-installation tasks that
are required before you can log on.
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Post-installation configuration

Adding the IBM HTTP server as an unmanaged Node on the Deployment
Manager

1. Log in to the Deployment Manager console by using the WebSphere Application Server
Administrator credentials and go to System administration > Nodes. Then, click the Add
Node. Select Unmanaged node from the list and click Next to continue.
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Figure 110. Deployment Manager console - Add node

___2. Onthe Node configuration screen, enter the name, the host name, and platform type of the
HTTP server, and click Apply then Save.
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Figure 111. Deployment Manager console - Nodes - New
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3. Next, go to Servers > Server Types > Web servers and select New. Select the web server
node that is created previously, enter a Server name, and for type, select IBM HTTP Server.

Click Next to continue.
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Figure 112. Deployment Manager console - Create new web server definition

__4. Onthe web server template selection page, keep the default IHS option and click Next.
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Figure 113. Deployment Manager console - Create new web server definition - Select a web server template
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__ 5. On the web server properties page, enter the correct properties for the HTTPServer

including location and credentials and click Next.
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Figure 114. Deployment Manager console - Create new web server definition - Enter the properties for the new web server

___ 6. Onthe Summary of actions page, review the information, click Finish, and then Save to
complete the web server definition. You should now see the HTTP server that is listed under

Web servers.
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Figure 115. Deployment Manager console - Web servers
__ 7. Now synch the nodes and then return to Servers > Web servers to Generate Plug-in and

then Propagate Plug-in.
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___ 8. Next, click the web server to open it and select Plug-in properties
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Figure 116. Deployment Manager console - Web servers

__ 9. From the repository copy of web server plug-in files section, click Copy to Web server key

store directory. You should see the following result:
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Figure 117. Deployment Manager console - Web servers - Plug-in properties
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Adding certificates to the WebSphere truststore

__ 1. From the WebSphere Admin console, go to Security > SSL Certificate and Key
Management.
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Figure 118. WebSphere Admin console - SSL certificate and key management

__ 2. Next, select Key stores and certificates and choose CellDefaultTrustStore.
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Figure 119. WebSphere Admin console - SSL certificate and key management - Key stores and certificates
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__ 3. Select Signer Certificates and click Retrieve from port.
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Figure 120. WebSphere Admin console - Signer certificates

___ 4. Enter the host name, port, and alias details and then click Retrieve signer information.
Click Apply and Save.
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Figure 121. WebSphere Admin console - SSL certificates and key management

You should now restart your HTTPserver, DMGR, and Nodes.

90 IBM Connections 4.5 Deployment Scenarios © Copyright IBM Corp. 2013

Course materials may not be reproduced in whole or in part
without the prior written permission of IBM.



Deployment Scenarios

Updating web addresses that Lotus Connections uses to access content

As you are using a remote HTTP server, you must update the web addresses for all Connections
applications in the LotusConnections—-config.xml file. You can do it by using the wsadmin client,
but in this case it is done by editing it from the file system and then restarting the configuration.

1. First, back up
c:\IBM\WebSphere\AppServer\profiles\DmgrO0l\config\cells\dmgrCell01l\Lotus-Con
nections-Config\LotusConnections-config.xml. Then, open the file for editing.

2. Update all href and ss1-href values to reflect the host name of the HTTP Server and
remove all port numbers.

Example before editing:

<aloe:merviceReferance bBootpirapHost=® ponnections . example . com® bootstrapPori= " 2811" ¢ lustecHame="LotusConnedtione"
<aloorhrefs
calorheefPathPeEefixs fackivitienc/alor  heefPathPEefixs
<mlocistatic href="http:/ foonnections. cxample . com; 2001° =3l heef="httpe: ffoonnect ione . exanple, com: 3444 7 %
caloc! interService nraf="hitps: ffconnections . example . com: S044° />
«fmlocihoel>
</slocisecviceReferences

Figure 122. Editing the LotusConnections-config.xml (before)

Example after editing:

calop:ssrviceleference hooracrapioscs® connections . example .com® booratrapPorce2811° =luscerNases*LotusConneotions®
<aloc:hrefs
cmlocrhrefPachPref ixsfactivitien</sloo href PachPrel 1n
c@FlpEiatatic heef="hitp:/fconneclions, sxample, com®™ 35 |_:|:|-r""h‘ltp::l|l'l|l'rnl'u|r1'l ijune, sxample , com® />
£mlociinterService href="hitps: ffoconnections. example . com® />
ofaloc:hrets
«falocisecviceRe farences

Figure 123. Editing the LotusConnections-config.xml (after)

___3. Save your changes and then sync your nodes again. You should also regenerate and
propagate your HTTP plug-in from Servers\Server types\web servers.
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Figure 124. Web servers
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Vs 'M}n’ Note ~

Before you use Connections, you must configure home page administration. See Configuring the

home page administrator,
http://www-10.lotus.com/1dd/lcwiki.nsf/xpDocViewer.xsp?lookupName=IBM+Connections+

4.0+documentation#action=openDocumenté&res title=Configuring the Home page administ
rator ic40&content=pdcontent.

A J

4. Restart your config and you should now be able to log in to Connections from your home
page. Log in with a user from your LDAP repository and you come to "Getting Started with

IBM Connections" on the home page.

Congratulations! You can now start working with IBM Connections 4.5.
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Figure 125. Getting started with IBM Connections
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Extra suggested configuration steps

Setting path variables for search

During Connections installation, the stellent folder is added to the Shared Content Store
\\ConnectionsShare\search\stellent and the FILE CONTENT CONVERSION variable is set to
point to this folder. In a multi-node cluster, run it on the nodes themselves and not the shared area.

__ 1. Copy the stellent folder from \\ConnectionsShare\search\stellent to the local drive,
for example, C:\connections\stellent on each node. Make sure to grant read/write
privileges to the folder.

___2. Fromthe WebSphere administration console, go to Environment > WebSphere Variables.
Locate FILE CONTENT CONVERSION and update the value to reference exporter.exe, that
is, C:\connections\stellent\dcs\oiexport\exporter.exe.
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Figure 126. WebSphere admin console - Environment - WebSphere Variables
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This change requires a restart.
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Enabling fast downloads for files and wikis

W
Note
e A N
This step is optional but was configured on this test environment.
A\
Important
~ I ™ N

Back up httpd.conf, files-confg.xml and wikis-config.xml before making and changes!

.

J

From your Deployment Manager, go to
C:\IBM\Connections\plugins\ihs\mod ibm local redirect\win ia32-ap22 and copy
mod ibm local redirect.soto C:\IBM\HITPServer\modules.

Now edit your httpd.conf file under C:\IBM\HTTPServer\conf\httpd.conf and add the
following lines:

LoadModule ibm local redirect module modules/mod ibm local redirect.so
LoadModule env module modules/mod env.so

7

. Note

e I
This content should exist in your file.
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3. Also add the following sections, updating paths as per your Shared Content location:

Alias /downloadfiles "//dmgrHTTPsrv/ConnectionsShare/lcshare/files/upload/"
Alias /downloadwikis "//dmgrHTTPsrv/ConnectionsShare/lcshare/wikis/upload/"

<Directory "//dmgrHTTPsrv/ConnectionsShare/lcshare/files/upload/">
Order Deny,Allow

Deny from all

Allow from env=REDIRECT FILES CONTENT

</Directory>

<Directory "//dmgrHTTPsrv/ConnectionsShare/lcshare/wikis/upload/">
Order Deny,Allow

Deny from all

Allow from env=REDIRECT WIKIS CONTENT

</Directory>

<Location /files>

IBMLocalRedirect On
IBMLocalRedirectKeepHeadersX-LConn-Auth, Cache-Control, Content-Type, Content-D
isposition,Last-Modified, ETag, Content-Language, Set-Cookie

SetEnv FILES_CONTENT true

</Location>

<Location /wikis>

IBMLocalRedirect On
IBMLocalRedirectKeepHeadErsX-LConn-Auth, Cache-Control, Content-Type, Content-D
isposition, Last-Modified, ETag, Content-Language, Set-Cookie

SetEnv WIKIS CONTENT true

</Location>
4. Save this file and restart your HttpServer.

5. Next you need to edit the files-config.xml and wikis-config.xml files from your
LotusConnections-configfolder on the deployment manager to enable, in this case
C:\IBM\WebSphere\Appserver\profiles\Dmgr0l\config\cells\dmgrcell01l\LotusConn
ections-config:

<download>

<modIBMLocalRedirect enabled="true"
hrefPathPrefix="/downloadfiles" />
<stats>

<download>

<modIBMLocalRedirect enabled="true"
hrefPathPrefix="/downloadwikis" />
<stats>

6. Save the changes and synch to your nodes. You will need to restart Connections for this
change to take affect.
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